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0003 1. Overview

Features

New 36×24 mm Full Frame CMOS 

Image Sensor

Supports image capture at resolutions up to 6048 

× 4032 pixels.* By switching the imager mode, the 

unit can natively support many shooting formats, 

including Super 35 24.3 × 12.8 mm, 4096 × 2160 

pixel resolution (equivalent to 3-perforation 

motion picture film) and 4:3 Anamorphic* 

Super 35 24.3 × 18.3 mm, 4096 × 3024 pixel 

resolution (equivalent to 4-perforation motion 

picture film).
* Full Frame and Anamorphic modes require licenses sold 

separately.

Wide Latitude

The unit supports 15+ stops of latitude. It features 

very low noise for delivering phenomenal images 

in conditions from searing sunlight to almost 

no light, allowing for unprecedented creative 

freedom in grading.

Wide Color Space Capture

Images can be captured in a color space that 

exceeds DCI-P3. The degree of freedom in the 

grading is dramatically improved when using 

Sony’s S-Gamut3.Cine color space together with 

S-Log3.

PL Lens Mount

Equipped with the industry-standard PL lens 

mount. The lens mount supports Cooke /i 

technology, and lens information is recorded as 

metadata frame by frame.

Compact Body and Intuitive 

Operation

A relatively compact design for a device equipped 

with a large Full Frame image sensor, achieved 

using Sony’s miniaturization technology, which 

allows easier shooting in confined spaces or on 

drones.

The position, shape, and size of the control 

buttons reflect the requirements of camera 

operators for intuitive operation. They also feature 

backlighting for ease of use in dark locations.

Engineered to Survive

The chassis is made from magnesium alloy for 

high robustness and durability. The ventilation 

system is completely isolated from all electronic 

components to prevent ingress of dust, sand, and 

liquids.*

The silent-running fan can be cleaned or even 

swapped out on set quickly and easily to maintain 

high redundancy.
* Design protects against dust and rain, but cannot 

completely prevent the ingress of dust and liquid.

Modular design

Features a fully modular design, allowing you 

to flexibly support various rigs and peripheral 

equipment according to the shooting application. 

The top handle and viewfinder are easily 

adjustable to maintain ergonomic balance and 

ease of use with lenses. The height of the optical 

axis is the same as the PMW-F55, permitting the 

use of peripheral devices used with the PMW-F55. 

And an optional AXS-R7 Portable Memory 

Recorder can be securely attached to the rear of 

the unit using four hex screws.

8-Position Optical ND Filter

Employs an 8-position optical ND filter. It offers 

a wide ND range of 0.3ND (1/2 = 1 stop) to 

2.4ND (1/256 = 8 stops) that reduces time lost 

on set changing external ND filters. The ND filter 

mechanism is servo-controlled.

Intuitive and Familiar On-Set 

Operation

The menu screen is available from both sides of 

the camera, with the main control display on the 

Assistant side of the camera for fast access to the 

camera settings by the camera assistant while 

shooting.

An OLED mini display on the Operator side allows 

the operator to access commonly accessed 

features such as ND filter position, shutter, white 

balance, and exposure index (EI), making it 

convenient for the operator to check the status of 

the unit.

Various Recording Formats

The unit supports recording on SxS memory cards 

in XAVC and MPEG HD formats. In addition, it can 

record in 16-bit RAW or X-OCN format onto AXS 

memory cards when used in combination with an 

optional AXS-R7 Portable Memory Recorder.
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Effective Picture Size

The unit supports shooting in the following effective picture sizes.

[Note]
A software license is required to shoot in 6K 3:2 and 4K 4:3.

6K 3:2

4K 4:3

4K 17:9 
(DCI 4K)

3.8K 16:9 
(Ultra HD)

Software Licenses

You can select software licenses (optional) according to the intended usage of the unit.

Software licenses are installed using Maintenance > License Options (page 51) in the full menu.

Software license Imager mode Effective number of pixels W × H (mm) Project frame rate

License not required 3.8K 16:9 3840 × 2160 22.8 × 12.8 23, 24, 25, 29, 50, 59

4K 17:9 4096 × 2160 24.3 × 12.8 23, 24, 25, 29, 50, 59

Anamorphic License 4K 4:3 4096 × 3024 24.3 × 18.3 23, 24

Full Frame License 6K 3:2 6048 × 4032 35.9 × 24.0 23, 24

[Note]
Recording in 6K 3:2 is supported, but playback is not supported.
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System Configuration

MPC-3610

VCT-FSA5 
Shoulder Adaptor

DVF-L700 
Viewfinder 
(VF cable (A-2201-632-A or 
A-2201-633-A) is required)

DVF-EL200 
Viewfinder

ECM-680S, ECM-678, 
ECM-674 
Microphone 
(EC-0.5X3F5M is required)

Microphone Holder (A-2182-620-A) 
Rod Clamp (A-2182-621-A) 
Rod (4-684-612-01)

SBP-256D, SBP-128B/C/D, SBP-64A/B/C/D, SBP-32,  
SBS-64G1A/B, SBS-32G1A/B 
SxS Memory Card  
 
QD-S64E, QD-S32E, QD-N64, QD-M128A, QD-M64A, 
QD-M32A, QD-G128A/E, QD-G64A/E, QD-G32A/E 
XQD Memory Card 
(QDA-EX1 XQD ExpressCard Adaptor is required)

SBAC-US30/UT100 
USB Card Reader

AC-DN2B, AC-DN10 
AC Adaptor

AXS-AR1 
AXS Memory Card Reader

BP-FL75, BP-FLX75 
Battery Pack

SCL-PK6, 
SCL-P11X15 
S35 PL Lens

CBKZ-3610A, 
CBKZ-3610AM, 
CBKZ-3610AW 
Anamorphic 
License

CBKZ-3610F, 
CBKZ-3610FM, 
CBKZ-3610FW 
Full Frame License

Anamorphic Lens

Full Frame Lens

AXS-R7 
Portable Memory  
Recorder

AXS-A256S24, AXS-A512S48, 
AXS-A512S24, AXS-A1TS48,  
AXS-A1TS24 
AXS Memory Card

AXS-AR1, AXS-CR1 
AXS Memory Card 
Reader
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Location and Function of Parts

Operator Side

4

678910111213

15

16

14

1 2 3

5

Air inlet

SxS memory card  
slot block (page 7)

1. ASSIGN (assignable) buttons 1/2 (page 32)

Assign functions using the EDIT page of the 

user functions screen (page 32).

The assigned function toggles between on/off 

(enable/disable) or is activated with each 

press.

2. ASSIGN (assignable) lamps 1/2 (page 32)

Each lamp is lit orange when the assigned 

function is on (enabled) or activated, and not 

lit when the function is off (disabled).

3. Mini display ITEM keys 1 to 3

Controls the operation of functions on the 

mini display (page 55).

4. Mini display

Displays various setup items, such as shutter 

angle, that you can check or modify 

(page 55).

5. ACCESS lamps (SLOT A/B)

Each lamp is lit when the recording media in 

SxS card slot A/B is the target for recording/

playback and when data is being written to or 

read from the recording media in SxS card slot 

A/B (page 21).

6. Network connector (RJ-45)

Not supported in firmware version 1.0.

7. CLIPS button

Not supported in firmware version 1.0.

8. Power switch

Set to the ON position () to turn the power on. 

Set to the OFF position () to turn the power 

off.

 [CAUTION]

ˎˎ This unit uses a small amount of standby power 

even when the power switch is set to OFF. Remove 

the battery pack if the unit will not be used for a 

prolonged period.

ˎˎ When removing the battery pack or the DC IN 

power, be sure to first set the power switch to the 

OFF position. Interrupting the power supply during 

recording or during memory card access could cause 

a malfunction.

9. HOME button

Press to clear the item selection display and 

return to the Home screen on the mini display .

If pressed when the unit is in playback state, 

the unit transitions to shooting mode 

(page 55).

10. LOCK switch

Locks the operation of the buttons on the 

Operator side. When locked, the switch 

background LED lights in orange.

11. Headphones connector (stereo mini jack)

Connect to earphones for audio monitoring. 

You can monitor the input audio during 

shooting/recording and playback sound 

during playback (page 54).

12. Built-in speaker

You can monitor the input audio during 

shooting/recording and playback sound 

during playback. The speaker also sounds 

alarms to reinforce visual warnings 

(page 54).

If you connect earphones to the headphones 

jack, the speaker output is suppressed 

automatically.

13. REC ACTIVE lamp

The lamp is lit green when the REC button is 

enabled.

14. ASSIGN (assignable) lamp 3 (page 32)

The lamp is lit orange when the assigned 

function is on (enabled) or activated, and not 

lit when the function is off (disabled).

15. REC (recording start/stop) button/lamp

Press to start recording, turning the REC lamp 

on. Press again to stop recording, turning the 

REC lamp off (page 57).

The REC lamp flashes when a device error or 

warning occurs.

16. ф mark

The ф mark is on the same plane as the image 

sensor.

To measure the precise distance between the 

unit and the subject, use the ф mark as a 

reference.
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SxS memory card slot block (page 21)

The SxS memory card slots are located behind the 

cover.

1

3

2

1. SxS memory card slots A/B

2. Manufacturer calibration terminal

Manufacturer terminal for calibration and 

servicing (cannot be used by users).

3. SLOT SELECT (SxS memory card select) 

button

Press to switch the active slot.

Assistant Side

1 2 3 4

6

5

7

8

9

1011
12

13
14

15
16

17

18

1 2 3

4 5 6

1. ASSIGN (assignable) button 4 (page 32)

Assign functions using the EDIT page of the 

user functions screen (page 32).

The assigned function toggles between on/off 

(enable/disable) or is activated with each 

press.

2. ASSIGN (assignable) lamp 4 (page 32)

The lamp is lit orange when the assigned 

function is on (enabled) or activated, and not 

lit when the function is off (disabled).

3. Sub display

Allows you to check the operation status of 

the unit and make various settings 

(page 27).

With the Home screen displayed, press and 

hold the BACK button (page 8) and turn 

the SEL/SET dial to adjust the brightness of the 

sub display and mini display.

The brightness can also be adjusted using 

Technical > Control Display > Brightness level 

(page 50) in the full menu.

4. Sub display ITEM keys 1 to 6

Controls the operation of functions on the sub 

display (page 35).

5. Tape measure hook

The tape measure hook is on the same plane 

as the image sensor. To measure the precise 

distance between the unit and the subject, use 

the tape measure hook as a reference. You can 

attach the end of a tape measure to the hook, 

and measure the distance from the subject.

6. HOME button

Press to clear the display and return to the 

Home screen on the sub display (page 29).

If pressed when the unit is in playback state, 

the unit transitions to shooting mode.

7. MENU (menu display on/off) button  

(pages 35, 41)

Press the MENU button to display the menu 

screen on the sub display. Press and hold the 

MENU button for 2 seconds or longer to 

display the full menu screen on the sub 

display. Press the button during menu screen 

or full menu screen display to return to the 

previous screen display.

8. SEL/SET (select/set) dial (MENU dial)

Changes the item selection or a setting within 

the menu (pages 29, 35, 41).

9. +48V power lamp

Lights in green if the AUDIO IN switch is set to 

MIC and +48 V phantom power is supplied on 

the AUDIO IN connector. It is not lit if phantom 

power is not supplied.

You can turn +48 V phantom power on/off 

using Audio category > Audio Details > Audio 

Configuration > Phantom Power +48V 

(page 48) in the menu.

10. AUDIO IN (audio selector) switch

Select the input signal type corresponding to 

the audio source connected to the AUDIO IN 

connector.

LINE: When connecting an external analog 

audio signal source 

AES/EBU: When connecting an external digital 

audio signal source

MIC: When connecting a microphone.
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11. AUDIO IN connector (XLR 5-pin)

Input external microphone or audio 

equipment signals.

When the audio source is set to LINE or MIC 

using the AUDIO IN switch, this connector 

functions as the AUDIO IN CH-1 and AUDIO IN 

CH-2 connector.

When the audio source is set to AES/EBU using 

the AUDIO IN switch, this connector functions 

as an AUDIO IN CH-3/4 connector.

12. BACK button

Cancels the menu setting and moves up one 

level in the menu hierarchy during menu 

display. Cancels the execution process or 

pending process during process execution/

pending display (pages 29, 35, 41).

13. LOCK switch

Locks the operation of the buttons on the 

Assistant side. When locked, the switch 

background LED lights in orange.

14. ACCESS (SD card access) lamp (page 23)

15. REC ACTIVE lamp

The lamp is lit green when the REC button is 

enabled.

16. REC (recording start/stop) button/lamp

Press to start recording, turning the REC lamp 

on. Press again to stop recording, turning the 

REC lamp off (page 57).

The REC lamp flashes when a device error or 

warning occurs.

17. CLIPS button

Press to display the clip list screen on the sub 

display to enable clip operations (page 52).

To switch from playback mode to shooting 

mode, press the HOME button.

18. USER button

Press to display the user function list on the 

sub display, and to operate the ITEM keys 1 to 

5 user function buttons.

ITEM key 6 is the user function list EDIT button. 

Press this button to display the function 

selection screen for the user function buttons 

and assignable buttons. Press again when the 

user functions screen is displayed to return to 

the previous display (page 32).

Front

1

23

4

5

1. ASSIGN (assignable) button 3 (page 32)

Assign functions using the EDIT page of the 

user functions screen (page 32).

The assigned function toggles between on/off 

(enable/disable) or is activated with each 

press.

2. PL lens mount adaptor (page 17)

3. VF (viewfinder output) connector 

(page 19)

4. LENS connector (12-pin) 

Not supported in firmware version 1.0.

5. 24V OUT connector (DC OUT 24 V, Fischer 

3-pin)

24 V DC power supply output connector 

(page 59).

The output voltage and maximum output 

current of this connector vary depending on 

the input voltage to the unit. The maximum 

current includes the output current from the 

24V OUT connector on the rear panel 

(page 9).

11 V to 17 V input

Output voltage : 24 V

Maximum output current: 1.0 A

22 V to 32 V input

Output voltage: Same as the input voltage

Maximum output current: 2.0 A
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Rear

2

1

3

4

5

6

7

8

9

10

11

12

13

1. 24V OUT connector (DC OUT 24 V, Fischer 

3-pin)

24 V DC power supply output connector 

(page 59).

The output voltage and maximum output 

current of this connector vary depending on 

the input voltage to the unit. The maximum 

current includes the output current from the 

24V OUT connector on the front panel 

(page 8).

11 V to 17 V input

Output voltage : 24 V

Maximum output current: 1.0 A

22 V to 32 V input

Output voltage: Same as the input voltage

Maximum output current: 2.0 A

2. 12V OUT connector (DC OUT 12V, Hirose 

4-pin)

12V DC power supply output connector 

(page 59).

The output voltage and maximum output 

current of this connector vary depending on 

the input voltage to the unit.

11 V to 17 V input

Output voltage: Same as the input voltage

Maximum output current: 1.0 A

22 V to 32 V input

Output voltage : 15 V

Maximum output current: 0.8 A

3. MONITOR OUT connector (BNC type)

HD SDI monitor signal output connector 

(page 59).

4. GENLOCK (genlock input) connector (BNC 

type)

To genlock the unit to an external source or to 

lock the timecode of the unit to an external 

source, input an external reference signal.

Digital signal and analog signal input are 

supported.

Digital signal: 1.5G HDSDI interlaced signal

Analog signal: HD sync, Analog

5. TC IN (timecode input) connector (BNC type)

To lock the timecode of the unit to an external 

source, input a reference timecode signal.

6. AUX connector (LEMO 5-pin)

Outputs the timecode signal (page 60).

7. REMOTE (remote control) connector (8-pin)

Not supported in firmware version 1.0.

8. 12V/24V (DC power input) connector 

(page 14)

DC power supply input connector for external 

power supply to the unit. Supports 12 V and  

24 V input voltages.

No. Signal

1 GND

2 NC

3 NC

4 DC IN (11 V to 17 V or 22 V to 32 V)

9. Battery attachment terminal (page 14)

10. SDI OUT 1 to 4 (serial digital output) 

connectors (BNC type) (page 59)

11. Battery pack mount (page 14)

12. Battery release lever (page 14)

13. HDMI OUT connector (page 59)
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Top

1 2 3 4

1. External device connector

Not supported in firmware version 1.0.

2. Release button (page 16)

3. Handle/VF attachment mount (page 16)

4. Accessory mounting screw holes

Type of screw: 1/4-20UNC (8)

Type of screw: 3/8-16UNC (10)

Length of engagement: 10 mm (3/8 inch) or 

less

Bottom

3

1 2

Air vent

1. Tripod plate attachment holes

Type of screw: 1/4-20UNC (2)

Type of screw: 3/8-16UNC (4)

Length of engagement: 9 mm (3/8 inch) or less

2. Bottom cover

Remove the four hex screws to remove the 

cover.

3. SD card slot (page 23)
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Viewfinder Screen

During shooting (recording or standby) and playback, the status and settings of the unit are 

superimposed over the picture on the viewfinder screen.

Information displayed on the screen while recording

Fixed-24 FPS ND EI +0. 02180.0 2 . 4 1250 3200 BAT 

 

min120 

14.5

T2.8

12:34:56:00 A001C001 Rec

mm

7.9
ft

VF

R709

MON

D.Spd

Peak

SDI 1/2

LOG

SDI 3/4

Look

Zebra

R709

HDMI

SDI
Stop

R709

AAXS 120 min BSxS 180 min 1 2

4K

4:3

2.0x

SxS

LOG

Sub

Look

MPG

Look Info:R709 (800%)

X-OCN ST / MPEG 422

25

1 2 3 64 5 7 9

2021222324

10

8

11

14
15
16
17
18

19

12 13

28

30
29

26
27

31

1. Recording frame rate indicator

Displays the recording frame rate and project 

frame rate.

2. Shutter angle/shutter speed indicator

Displays the shutter angle or shutter speed of 

the electronic shutter.

3. ND filter indicator

Displays the density of the ND filter. The 

display value is a LOG (base 10) value 

(page 42).

0.3: 1/2

0.6: 1/4

0.9: 1/8

1.2: 1/16

1.5: 1/32

1.8: 1/64

2.1: 1/128

2.4: 1/256

4. Thermometer icon

Displayed when a high temperature warning 

message is issued.

The description is displayed in the Info 

category in the menu.

5. Warning icon

Displayed when other than a high 

temperature warning message is issued.

The description is displayed in the Info 

category in the menu.

6. Exposure index indicator

Displays the exposure index (EI) value.

7. Color temperature indicator

Displays the color temperature and Tint value 

of the white balance.

8. Look information display

Displays the selected Look (page 43).

9. Battery capacity/voltage indicator

Displays the following indicators according to 

the type of battery power source.

Battery type Display

InfoLithium 

battery

Battery remaining capacity 

and remaining recording 

time

Anton/Bauer 

battery

Remaining battery capacity 

(% indicator)

Other batteries Input voltage

10. VF LUT indicator

Displays the viewfinder LUT (page 42).

11. VF Double Speed Scan indicator

Displays the on/off state of the function for 

doubling the frame rate of the viewfinder 

display.

12. VF Peaking indicator

Displays the on/off state of the peaking 

function of the viewfinder display.

13. VF Zebra indicator

Displays the on/off state of the zebra function 

of the viewfinder display (page 33).

14. SDI OUT 1/2 connector LUT indicator

Displays the LUT setting of the SDI OUT 1/2 

connectors (page 42).

15. SDI OUT 3/4 connector LUT indicator

Displays the LUT setting of the SDI OUT 3/4 

connectors (page 42).

16. Monitor LUT indicator

Displays the LUT setting of the Monitor output 

(page 42).

17. HDMI LUT indicator

Displays the LUT setting of the HDMI output 

(page 42).
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18. SDI output REC trigger indicator

Displays the SDI output REC trigger status.

State Display

Technical > System Configuration > SDI Rec Remote 

Trigger in the full menu

Recording command 

superimposed on the 

SDI output

Off – (Blank)

HD SDI Remote I/F Stop command Top: SDI

Bottom: Stop

Rec command Top: SDI

Bottom: REC

Parallel Rec Stop command Top: SDI-P

Bottom: Stop

Rec command Top: SDI-P

Bottom: REC

19. Audio level meter indicators

Displays the levels of audio channels 1 and 2 

while recording.

20. Recording media state/remaining capacity 

indicator for each media slot

Displays the state and remaining capacity of 

the media in SxS memory card slots A/B and 

AXS memory card slots A/B.

A  mark on the left of “AXS” or “SxS” indicates 

the recording target media.

An indicator  on the upper right of the slot 

A/B icon on the right of “AXS” or “SxS” indicates 

the playback target media (green indicator 

indicates media is being played).

A  icon is displayed for media if a condition 

occurs that could impact recording.

21. Recording media format (codec) indicator

Displays the format of the recording on an AXS 

memory card or an SxS memory card .

22. Recording status indicator

Displays the following recording operation 

states of the unit.

Display Description

ˎRec During recording

Stby Recording standby

23. Clip name display

Displays the first 8 characters of the name of 

the next clip to be recorded in recording 

standby mode.

Displays the first 8 characters of the name of 

the clip currently being recorded when 

recording.

24. Time data display

Displays the duration or timecode, depending 

on the TC/Media category > TC Display setting 

in the menu (page 36).

25. Iris position indicator

Displays the iris position (only when a lens that 

is compatible with the iris setting display 

function is attached).

26. Focus position indicator

Displays the focus position (only when a lens 

that is compatible with the focus setting 

display function is attached).

27. Zoom position indicator

Displays the focal length of the zoom 

(displayed only when a lens that supports the 

zoom setting indicator is attached).

28. Simultaneous recording status indicator

Displays the sub clip recording format in 1-slot 

simultaneous recording mode (page 58).

29. SxS Sub LUT indicator

Displays the LUT setting to register for a sub 

clip in SxS 1-slot simultaneous recording 

mode.

30. SxS LUT indicator

Displays the LUT setting for SxS recording.

31. Effective picture size indicator

Displays the effective picture size and whether 

anamorphic de-squeeze conversion is applied, 

set using Project category > Imager Mode in 

the menu (page 36).
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Information displayed on the playback screen

The following information is displayed on the playback picture.

12:34:56:00 A001C001 Play XCON ST AAXS 1 2

BAT min120 

87

54321

6

1. Time data display

Displays the duration or timecode, depending 

on the TC/Media category > TC Display setting 

in the menu (page 36).

2. Playback clip name display

Displays the first 8 characters of the name of 

the playback clip.

3. Playback status indicator

Displays the playback status.

4. Playback media format (codec) indicator

Displays the recording format (codec) of the 

playback clip.

5. Playback media indicator

Displays the type of recording media being 

played.

A  icon appears on the right if the memory 

card is write-protected.

6. Audio level meter indicators

Displays the levels of audio channels 1 and 2 

during playback.

7. Thermometer icon

Displayed when a high temperature warning 

message is issued.

The description is displayed in the Info 

category in the menu.

8. Warning icon

Displayed when other than a high 

temperature warning message is issued.

The description is displayed in the Info 

category in the menu.
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Preparing a Power Supply
You can use a battery pack or AC power via an AC 

adaptor.

For safety, use only the Sony battery packs and AC 

adaptors listed below.

Lithium-ion battery pack
BP-FL75

BP-FLX75

AC adaptor
AC-DN2B

AC-DN10

Using a Battery Pack

Insert the battery pack into the battery pack 

mount (page 9) of the battery adaptor, then 

slide the battery pack down to lock it in place.

To remove it, unlock the battery pack by sliding 

it up while pressing the battery release lever 

(page 9), then remove it.

[Notes]

ˎˎ Before use, charge the battery pack with the battery 

charger.

ˎˎ A warm battery pack immediately after use may not be 

able to be fully recharged.

ˎˎ Remove the battery adaptor while supporting the unit 

by hand.

Checking the remaining battery charge

When recording or playback is in progress using 

the battery pack, an icon to show the current 

battery remaining time and battery voltage are 

displayed on the sub display screen (page 27) 

and viewfinder screen (page 11).

The unit indicates the remaining usage time in 

minutes by calculating the available time with 

the battery pack if operation is continued at the 

current rate of power consumption.

If the remaining battery charge becomes low

If the remaining battery charge decreases to a 

certain level during operation, the remaining 

battery capacity indicator flashes and the REC 

lamp flashes to warn you.

If the remaining charge further decreases to a 

level at which operation cannot be continued, a 

battery-empty message appears.

Replace the battery pack with one that is fully 

charged.

To change the message levels

Change levels using Technical > Battery 

(page 49) in the full menu.

Using AC Power (DC IN Power) 

The unit works with AC power using the AC-DN10 

(optional) or AC-DN2B AC adaptor (optional) and 

CCDD-X2 DC cable (optional).

11 V to 17 V and 22 V to 32 V input voltage ranges 

are supported.

[Note]
When switching to the DC IN power supply during battery 

operation, use a power supply with a voltage in the range 

12 V to 17 V or 22 V to 32 V.
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Setting the Clock
When you use the unit for the first time, the initial 

setup screen appears on the sub display when the 

power is turned on.

Set the date and time of the built-in clock using 

this display.

Time Zone

The value shows the time difference from UTC 

(Coordinated Universal Time). Change the setting 

if needed.

[Note]
When Time Zone is changed, the clock setting changes 

according to the time difference.

Setting the Date and Time

Turn the MENU dial (page 7) to move the 

cursor, then press the MENU dial to set each menu 

item. When you press the MENU dial when the 

cursor is on “Set,” the setting display disappears 

and the clock setting is completed.

After the initial setup screen disappears, you can 

change Time Zone and date/time settings using 

Maintenance > Clock Set (page 50) in the full 

menu.

[Notes]

ˎˎ If the clock setting is cleared because the backup battery 

fully discharged when no power was supplied (no battery 

pack and no DC IN connection), the initial setup display 

will be displayed when you next turn the unit on.

ˎˎ While the initial setup display is shown, no other 

operation, except turning the power off, is permitted until 

you finish the setting for this display.
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Attaching the VF Attachment

1 Slide the VF attachment on in the direction of 

the arrow to attach it.

2 Position the VF attachment in the desired 

front/rear position, then turn the lock lever to 

secure it in position.

1

2

Lock 
lever

 [Note]
You can also attach the VF attachment in the front/rear 

or left/right orientation.

To remove the VF attachment

Turn the lock lever to loosen, press the release 

button and slide the VF attachment off in the 

reverse direction from when attaching it.

Attaching the Handle

1 Slide the handle on in the direction of the 

arrow to attach it.

2 Position the handle in the desired front/rear 

position, then turn the lock lever to secure it in 

position.

2

1

Lock screw

Hex socket 
bolt

Lock 
lever

 [Notes]

ˎˎ You can also attach a lock screw using a hex wrench 

(5 mm) to secure it in position.

ˎˎ If the lock lever on the handle becomes loose during 

use, you can secure the handle by tightening a hex 

socket bolt (2 mm) beside the lock screw.

ˎˎ You can also attach the handle in the reverse 

orientation.

To remove the handle

Turn the lock lever to loosen, press the release 

button and slide the handle off in the reverse 

direction from when attaching it.

Attaching the VF Attachment and Handle
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Recommended lens (Super 35mm size)
SCL-PK6/F, SCL-PK6/M (set of 6 lenses, 20 mm/25 

mm/35 mm/50 mm/85 mm/135 mm)

SCL-PK3/F, SCL-PK3/M (set of 3 lenses, 20 mm/25 

mm/135 mm)

SCL-P11X15

For details about available lenses for the unit, contact a Sony 

service representative.

[CAUTION]

Do not leave the lens facing the sun. Direct 

sunlight can enter through the lens, be focused in 

the unit, and cause fire.

[Notes]

ˎˎ A lens is a precision part. Do not place the lens down with 

the mount side facing down. Attach the cap supplied 

with the lens.

ˎˎ The lens interface of the unit is configured by factory 

default for an SCL-P11X15 and lenses with Cooke type 

connector. To use an SCL-PK6, SCL-PK3, or other lenses 

that do not have a Cooke type connector, set Technical 

> System Configuration > Lens Interface (page 49) 

to Off in the full menu. If this setting is not correct, an 

alert message appears when the unit is turned on after 

attaching the lens.

Attaching a PL Mount Lens

1 Remove the mount cover from the lens mount 

by turning the PL mount lever 

counterclockwise.

PL mount 
lever

 [Note]
Turn the PL mount lever counterclockwise to the 

stopper position.

2 Insert the lens into the lens mount by aligning 

the concave part of the lens with the 

positioning pin on the upper right of the lens 

mount.

3 Secure the lens by turning the PL mount lever 

clockwise while holding the lens.

 [Note]
Do not turn the lens when attaching the PL mount lens. 

It may cause damage to the hot shoe pin.

To attach a Cooke /i lens

Align the contacts on the lens with the hot shoe of 

the unit. There are two connectors on the side of 

the lens adaptor, and either can be used.

To remove the lens

1 Turn the PL mount lever counterclockwise 

while holding the lens from underneath.

2 Pull the lens forward.

 [Notes]

ˎˎ If another lens will not be attached soon, carefully 

align the concave part of the mount cover, then 

secure the mount cover by turning the PL mount 

lever clockwise.

ˎˎ In firmware version 1.0, images will not be output 

normally if the PL mount adaptor is removed.

Adjusting the Flange Focal Length

The unit is shipped with the flange focal length 

already adjusted. If you need to adjust the flange 

focal length, remove the lens mount, and change 

the shims with those of the appropriate thickness. 

You can adjust the thickness by ±0.1 mm in 0.01 

mm increments.

Shims

The following shims are supplied with the unit.

0.05 mm × 1 (circular)

0.01 mm × 15 (1/3 arc)

1/3 arc shims should always be used as a set of 

three shims. Insert shims to increase the flange 

focal length. The unit is shipped with the flange 

focal length already adjusted using the following 

three types of shims.

0.10 mm (circular)

0.05 mm (circular)

0.01 mm (1/3 arc)

A seal is attached showing the shim thickness 

when shipped.

Mounting a Lens and Adjusting the Flange Focal Length
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Adjusting the flange focal length

1 Remove the six Torx screws and remove the PL 

mount flange.

1

PL mount flange

2 Loosen the four Phillips screws on both sides 

of the PL connectors (two locations), and 

remove the PL connectors and PL connector 

plates.

3 Attach shims to the PL mount adaptor (three 

locations).

33

33
33

22

22

PL connectors

PL connector plates

When using 1/3 arc shims

Attach shims that have the same thickness in 

all three locations.

Shims

When using circular shims

Attach with the surface that has markings on it 

facing the front.

Markings

Markings

4 Reattach the PC connectors (two locations) to 

their original positions, and tighten the four 

Phillips screws with 0.18 N·m tightening 

torque.

5 Reattach the PL mount flange in its original 

position, and tighten the six Torx screws to a 

tightening torque of 0.35 N·m using a T8 

torque wrench.

Cleaning the Filter

To clean the filter, first remove the adaptor. 

Exercise care when wiping the adaptor center 

part (shaded part) with a cloth or other material 

to prevent fibers adhering to surfaces. If fibers are 

adhering, wipe off using a soft brush.

Adaptor
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Attaching a Viewfinder
Available viewfinders for the unit
DVF-EL200: OLED color viewfinder

DVF-L700: LCD color viewfinder

Viewfinders are available separately.

This section describes attachment of the DVF-

EL200 as an example.

For details about attaching each viewfinder, refer to the 

operating instructions of the viewfinder.

[CAUTION]

Do not leave the unit with the eyepiece of the 

viewfinder facing the sun. Direct sunlight can 

enter through the eyepiece, be focused in the 

viewfinder, and cause fire.

[Notes]

ˎˎ Attach/remove the viewfinder while the unit is turned off.

ˎˎ A VF cable (A-2201-632 or A-2201-633-A) is required in 

order to attach the DVF-L700. Also, turn the unit on after 

setting the POWER switch of the DVF-L700 to the ON 

position.

Attaching a Viewfinder

1 Align the viewfinder shoe with the groove of 

the viewfinder mount on the VF attachment, 

and attach the viewfinder.

2 Turn the viewfinder lock lever in the LOCK 

direction to secure it in position.

2

1

Lock lever

3 Connect the viewfinder and unit using the VF 

connection cable.

Viewfinder side:

Position the connector with the mark (red) at 

the top, and fully insert the connector.

Camera side:

Alight the concave part of the VF connector 

with the connector mark (red), and fully insert 

the connector.

Clamper

 [Note]
Secure the cable in the clamper as required.

To remove the viewfinder

1 Disconnect the VF connection cable from the 

viewfinder and unit.

2 Turn the lock lever in the direction opposite to 

LOCK, then remove the viewfinder from the VF 

attachment.

Adjusting the Viewfinder Position

To adjust the front/rear position

1 Loosen one or both of the front/rear rod lock 

levers of the VF attachment.

2 Slide the VF attachment forward/rearward to 

adjust the viewfinder position.

11
11

22

Rod lock 
levers

3 Tighten the rod lock levers.

 [Note]
If a rod lock lever is difficult to turn, pull the lever out, 

turn it to a position where it is easier to operate, and 

then push the lever back in.
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To adjust the left/right position and height 

(angle)

1 Loosen the rod lock lever at the front of the VF 

attachment.

2 Slide the VF attachment rod left/right and turn 

the rod up/down to adjust the viewfinder 

position.

11

22
22

Lock screw

Rod lock lever

3 Tighten the rod lock lever.

 [Note]
When the rod lock lever is loosened, adjust the lock 

screw using a hex wrench (3 mm) to prevent the 

viewfinder from falling down.

To adjust the viewfinder angle

You can adjust the angle of the viewfinder while 

shooting.

1 Loosen the rotation lock lever on the 

viewfinder mount.

2 Turn the viewfinder up/down to adjust the 

angle.

11

22

Rotation lock lever

3 Tighten the rotation lock lever.
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This unit records audio and video on SxS memory 

cards (optional) loaded in the card slots.

About SxS Memory Cards

Use the following Sony SxS memory cards or XQD 

memory cards.*
* When using an XQD memory card, the XQD ExpressCard 

adaptor (QDA-EX1) is required.

The supported memory cards differ depending on 

the recording format.

SxS PRO+
SBP-256D, SBP-128B/C/D, SBP-64B/C/D: Supported 

for all recording formats.

SxS PRO
SBP-64A, SBP-32: 

MPEG 1920×1080P/i

SxS-1
SBS-64G1A/B, SBS-32G1A/B: 

MPEG 1920×1080P/i

XQD memory card S series, G series
QD-S64E, QD-S32E, QD-G128A/E, QDG64A/E, QD-

G32A/E: Supported for all recording formats.

XQD memory card N series, M series
QD-N64, QD-M128A, QD-M64A, QD-M32A: 

MPEG 1920×1080P/i

Operations are not guaranteed with other memory 

cards.

These memory cards comply with the ExpressCard 

standard.

For details on using SxS memory cards and usage-related 

precautions, refer to the instruction manual for the SxS memory 

card.

ˎˎ SxS, SxS PRO, and SxS-1 are trademarks of Sony 

Corporation.

ˎˎ XQD is a trademark of Sony Corporation.

ˎˎ The ExpressCard word mark and logo are 

owned by Personal Computer Memory Card 

International Association (PCMCIA) and 

are licensed to Sony Corporation. All other 

trademarks are the property of their respective 

owners.

Inserting an SxS Memory Card

1 Open the cover of the card slot block 

(page 7).

2 Insert the SxS memory card into the slot with 

the SxS label facing to the right.

The ACCESS lamp (page 6) lights in red 

then changes to green once the memory card 

is ready for use.

3 Close the cover.

ACCESS lamp status

Card slots A and B each have an ACCESS lamp that 

indicate the slot status.

Lamp Slot status

Lights in red Accessing the SxS memory 

card (writing/reading data)

Lights in green Standby (ready for recording 

or playback using the SxS 

memory card)

Off ˎˎ No SxS memory card is 

loaded. 

ˎˎ The loaded card is invalid. 

ˎˎ An SxS memory card is 

loaded, but the other slot is 

selected.

Removing an SxS Memory Card

1 Open the cover of the card slot block .

2 Pull out the SxS memory card.

[Note]
Data integrity is not guaranteed if the power is turned off or 

a memory card is removed while it is being accessed. Data 

on the card may be destroyed. Be sure that its ACCESS lamp 

is lit in green or off when you turn off the power or remove a 

memory card.

Switching Between SxS Memory 

Cards

When SxS memory cards are loaded in both slot A 

and slot B, you can press the SLOT SELECT button 

(page 7) to select the SxS memory card to use.

If a card becomes full, recording continues after 

automatically switching to the second card.

[Note]
The SLOT SELECT button is disabled while recording/

playback is in progress. The memory cards are not switched 

even if you press the button.

Handling SxS Memory Cards
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Formatting (Initializing) SxS Memory 

Cards

When an unformatted SxS memory card or an SxS 

memory card formatted in another specification 

is loaded, a message notifying you that the media 

has a different file system appears. In this case, 

format the memory card in the following way.

1 Select TC/Media category > Format Media in 

the menu.

2 Select SxS Slot A (slot A) or SxS Slot B (slot B), 

then press the MENU dial.

A confirmation screen prompting whether to 

format the card appears.

3 Press and hold ITEM key 1 and ITEM key 3 for 3 

seconds to execute formatting.

Formatting starts, a message is displayed 

during execution, and the ACCESS lamp lights 

in red.

When formatting ends, a completion message 

appears. Press the MENU dial to dismiss the 

message.

If formatting fails

A write-protected SxS memory card or memory 

card that cannot be used with this unit will not be 

formatted.

A warning message is displayed. Replace the card 

with an appropriate SxS memory card, according 

to the instructions in the message.

[Note]
All the data, including recorded pictures and setup files, are 

erased when a memory card is formatted.

Formatting while recording

Even while recording, the SxS memory card loaded 

in the other card slot can be formatted.

Checking the Remaining Recording 

Time

While shooting (recording or standby), you can 

check the remaining capacity on the SxS memory 

cards loaded in each slot using the recording 

media remaining capacity indicator on the Home 

screen of the sub display (page 27) or the 

viewfinder screen (page 11).

The available time for recording with the current 

video format (recording bit rate) is calculated 

according to the remaining space on each card 

and displayed in time units of minutes.

[Note]
A  icon appears if a memory card is write-protected.

Exchanging an SxS memory card

ˎˎ If the total remaining time on the inserted 

memory cards during recording becomes less 

than 5 minutes, the remaining media capacity 

indicator flashes, the REC lamp flashes, and a 

beep sound is emitted to warn you. Replace the 

cards with those that have sufficient space.

ˎˎ If you continue recording, the message “Media 

Full” appears, and recording stops when the 

total remaining recording time falls to 0.

[Note]
Up to approximately 600 clips can be recorded on one SxS 

memory card.

The display of remaining recording time changes to “0” 

and the message “Media Full” appears when the clip limit is 

reached.

Restoring an SxS Memory Card

If for any reason an error should occur in a memory 

card, the card must be restored before use.

If an SxS memory card that needs to be restored is 

loaded, a message prompting you to execute the 

restore operation is displayed on the sub display.

To start the restore process, select Execute by 

turning the MENU dial, then press the MENU dial.

The restoration starts.

During execution, a message is displayed and the 

ACCESS lamp lights in red.

When restoration ends, a completion message 

appears. Press the MENU dial to dismiss the 

message.

If restoration fails

ˎˎ A write-protected SxS memory card, or one on 

which an error occurred, cannot be restored. 

For such a card, a warning message is displayed. 

Release the write protection or replace the card, 

according to the instructions in the message.

ˎˎ An SxS memory card on which an error occurred 

may become usable again when reformatted.

ˎˎ In some cases, some clips can be restored while 

others cannot. Playback of the restored clips 

becomes possible again.

ˎˎ The following operation may restore an SxS 

memory card for which the message “Could not 

Restore Some Clips” is repeatedly displayed each 

time you try the restoration process.

[1] Copy the required clips to another SxS 

memory card.

[2] Format the unusable SxS memory card on 

the unit.

[3] Copy the required clips back to the newly 

formatted SxS memory card.

[4] Update the management file as described 

below.

[Note]
For restoration of media recorded with this unit, be sure to 

use this unit.

Media recorded with a device other than this unit or with 

another unit of different version (even of the same model) 

may not be restored using this unit.

Updating the management file

If clips cannot be played back, updating the 

management file on the card may improve the 

situation.

Use TC/Media > Update Media (page 45) in the 

full menu to update the management file.

If you write an XAVC file that is imported by RAW 

Viewer V2.2 or later to the “XDROOT\Clip” directory 

of an SxS memory card directly, that file can 

become playable by executing Update Media.
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You can store the configuration file of the camera 

on an SD card (optional). The stored file can be 

loaded from the SD card.

Supported SD Cards

SDHC memory cards* (Speed Class: 4 to 10, non-

UHS, Capacity: 2 to 32 GB)

SD memory cards* (File system: FAT 16, Capacity: 

up to 2 GB)
* Referred to as “SD cards” in this manual.

Inserting an SD Card

Insert an SD card into the SD card slot (page 10).

The ACCESS lamp (page 8) lights in red then 

changes to green once the memory card is ready 

for use.

ACCESS lamp status

Lamp Slot status

Lights in red Accessing the SD card 

(writing/reading data)

Off ˎˎ No SD card is loaded.

ˎˎ The loaded card is invalid.

Removing an SD Card

Press the SD card in slightly, then remove the card.

[Notes]

ˎˎ Data integrity is not guaranteed if the power is turned off 

or a memory card is removed while it is being accessed. 

Data on the card may be destroyed. Be sure that its 

ACCESS lamp is lit in green or off when you turn off the 

power or remove a memory card.

ˎˎ Make sure that the card does not pop out when inserting 

or removing it.

Formatting (Initializing) an SD Card

SD cards must be formatted the first time they are 

used in the unit.

SD cards for use in the unit should be formatted 

using the format function of the unit. It is also 

necessary to format an SD memory card if a 

caution message is displayed when the card is 

loaded.

If an SD card that was formatted in an 

unsupported format is loaded in the unit, a file 

system mismatch message is displayed.

1 Select TC/Media category > Format Media > 

SD Card in the menu, then press the MENU 

dial.

A confirmation screen prompting whether to 

format the card appears.

2 Press and hold ITEM key 1 and ITEM key 3 for 3 

seconds to execute formatting.

Formatting starts, a message is displayed 

during execution, and the ACCESS lamp lights 

in red.

When formatting ends, a completion message 

appears. Press the MENU dial to dismiss the 

message.

[Note]
All data is erased when an SD card is formatted, and the data 

cannot be restored.

To use media formatted with this unit in the slots 

of other devices

Make a backup of the media, then format it using 

the other device.

Handling SD Cards for Saving Configuration Data
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Using with AXS-R7
You can record video/audio in RAW or X-OCN 

to an AXS-R7 AXS (Access Memory Card System) 

Recorder (optional) by attaching the recorder to 

the unit.

[Note]
Update the AXS-R7 to version 1.1 before attaching it to 

the unit. After updating the version, remove the docking 

module from the AXS-R7 and attach the AXS-R7 to the unit. 

For details about updating the recorder, refer to the Update 

Guide for the AXS-R7.

Attaching the AXS-R7

[Note]
Attach/remove the AXS-R7 while the unit is turned off.

1 Unscrew the four hex screws (3 mm) on the 

rear of the unit, and remove the battery plate.

Battery 
plate

2 Unscrew the four hex screws on the rear of the 

AXS-R7, and remove the docking module from 

the AXS-R7.

AXS-R7

Docking module

3 Attach the AXS-R7 to the unit, and tighten the 

four hex screws.

AXS-R7

To remove the AXS-R7

Unscrew the four hex screws, and remove the 

AXS-R7.

Inserting an AXS Memory Card

1 Press the memory card slot cover open button 

to open the cover.

2 Insert the AXS memory card into the card slot 

with the label facing as indicated below.

Label

3 Close the cover.

Removing an AXS Memory Card

Open the memory slot cover of the AXS-R7, and 

pull out the AXS memory card.

[Note]
Data integrity is not guaranteed if the power is turned off or 

an AXS memory card is removed while it is being accessed. 

Data on the card may be destroyed. Be sure that its ACCESS 

lamp is lit in green or off when you turn off the power or 

remove a memory card.

Recording to an AXS Memory Card

You can select the format for recording to an AXS 

memory card using Project category > AXS Rec 

Format (page 36) in the menu.

[Note]
The AXS memory card in the AXS-R7 does not switch to 

the second card automatically, even if the card becomes 

full while recording. To switch cards, use the SLOT SELECT 

button on the AXS-R7 during recording standby mode.
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Formatting (Initializing) an AXS 

Memory Card

AXS memory cards must be formatted the first 

time they are used in the AXS-R7 attached to the 

unit.

Use the format function of the unit to format 

AXS memory cards for use in the AXS-R7. It is 

also necessary to format an AXS memory card if 

a caution message is displayed when the unit is 

turned on with the AXS recorder attached.

If an AXS memory card that was formatted in a 

format not supported by the AXS-R7 is loaded, a 

file system mismatch message is displayed.

1 Select TC/Media category > Format Media in 

the menu, then press the MENU dial.

2 Select AXS Slot A (slot A) or AXS Slot B (slot B).

A confirmation screen prompting whether to 

format the card appears.

3 Press and hold ITEM key 1 and ITEM key 3 for 3 

seconds to execute formatting.

Formatting starts, a message is displayed 

during execution, and the ACCESS lamp lights 

in red.

When formatting ends, a completion message 

appears. Press the MENU dial to dismiss the 

message.

[Note]
All data is erased when a memory card is formatted, and the 

data cannot be restored.

Checking the Remaining Recording 

Time

While shooting (recording or standby), you 

can check the remaining capacity on a loaded 

AXS memory card using the recording media 

remaining capacity indicator on the Home screen 

of the sub display (page 27) or the viewfinder 

screen (page 11).

The available time for recording with the current 

video format (recording bit rate) is calculated 

according to the remaining space of each card and 

displayed in time units of minutes.

[Note]
A  icon appears if an AXS memory card is write-protected.

Restoring an AXS Memory Card

If for any reason an error should occur in a memory 

card, the card must be restored before use.

If an AXS memory card that needs to be restored 

is loaded, a message prompting you to execute 

restoration is displayed.

To start the restore process, select Execute by 

turning the MENU dial, then press the MENU dial.

The restoration starts.

During execution, a message is displayed and the 

ACCESS lamp lights in red.

When restoration ends, a completion message 

appears. Press the MENU dial to dismiss the 

message.

If restoration fails

ˎˎ A write-protected AXS memory card or one on 

which an error occurred cannot be restored. For 

such a card, a warning message is displayed. 

Release the write protection or replace the card, 

according to the instructions in the message.

ˎˎ An AXS memory card on which an error 

occurred may become usable again when 

reformatted.

ˎˎ In some cases, some clips can be restored while 

others cannot. Playback of the restored clips 

becomes possible again.

[Note]
For restoration of media recorded with this unit, be sure to 

use this unit.

Media recorded with a device other than this unit or with 

another unit of different version (even of the same model) 

may not be restored using this unit.

Updating the management file

If clips cannot be played back, updating the 

management file on the card may improve the 

situation.

Use TC/Media > Update Media (page 45) in the 

full menu to update the management file.
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Sub Display
The sub display displays the Home screen, clip list screen, playback screen, menu screen, full menu screen, and user functions screen.

You can switch between the screens on the sub display using the buttons on the Assistant side of the unit.
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A001C003_180101HR

A001C004_180101WK

A001C005_180101S8

A001C006_180101GF

F Rev Play/Pause F Fwd

 FPS 60DC IN 15.0V

23.98fps

1 2

Dur 00:00:00:00

A 002/010SXS

x24

XAVC QFHD C480

Prev Stop/Clips Next

A001C002_160328WW OKSub

3.8K 16:9

Shooting 

 

 

Maintenance

Technical 

Shooting

Shutter

ND

Exposure Index  

White Balance     

LUT Select         

Look    

User functions screen

Home screen Clip list screen

Menu screen Full menu screen

Playback screen

USER button

USER button

MENU button

HOME button

HOME button

HOME button

CLIPS button

CLIPS button

CLIPS button

USER button

MENU button

MENU button
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Home Screen

Press the HOME button on the Assistant side to display the Home screen. You can check the status of the 

unit and set basic settings for the unit on the Home screen.

Fixed-24 90.0
FPS EI

Reel A001 Shot C004DC IN 15.0V

23.98fps

1 2

TCG

B 180 min

A 120 minSxS

Rec

1.8
ND WB

03+LookSDI 3/4:

SxS: Log

XAVC QFHD C480 Sub

SxS

3.8K 16:9

500
Shutter

00:00:00:00

3200

Item name/Setting 
value/Function 
display area

Status 
display area

Item name/Setting value/Function display area

Fixed-24 90.0
FPS EI Shutter

Reel Shot CDC IN V

23.98fps

1 2

TCG

B min

A minSxS

Rec

.81
ND WB

+
SxS:

XAVC QFHD C480 Sub

SxS

3.8K 00:00:00:00
15.0 A001

3/4:

Log

LookSDI

180

120

500

004

16:9

3200 03

1 2 3

4 5 6

ITEM key 4 ITEM key 5 ITEM key 6

ITEM key 3ITEM key 2ITEM key 1

[Note]
The areas labeled 1 to 6 correspond to ITEM keys 1 to 6 

(page 32). Press an ITEM key to select the corresponding 

item. The ITEM keys for functions displayed in orange text 

color are enabled. FPS selection using ITEM key 1 is not 

supported in firmware version 1.0.

1. FPS

Displays the video frame rate.

2. Exposure Index

Displays and sets the exposure index (EI).

3. Shutter

Displays and sets the shutter speed/shutter 

angle of the electronic shutter.

4. ND Filter

Displays and sets the ND filter position.

5. LUT

Displays and sets the monitor LUT.

6. WB (White Balance)

Displays and sets the white balance.

Status display area

Reel A Shot CDC IN V

23.98fps

1 2

TCG

B min

A minSxS

Rec

Sub

SxS

Ext
LK 3.8K 16:9

001 004

00:00:00:00
15.0

180

120 XAVC QFHD C480

1

9

2 3

5

4

7 6810

13
12
11

1. Time data display

Displays the duration or timecode, depending 

on the TC/Media category > TC Display setting 

in the menu (page 36).

Displays the type of data currently shown in 

the time data display, as follows.

TCG: Recorded timecode

TCR: Playback timecode

DUR: Duration

2. Frame rate indicator

Displays the value of the Project category > 

Project Frame Rate setting in the menu 

(page 36).

3. Imager mode indicator

Displays the Project category > Imager Mode 

setting in the menu, and de-squeeze 

information.

4. Clip name display

Displays “Reel: Camera ID + Reel Number” and 

“ShotNumber”.

5. Audio level meters

Displays the audio recording or playback 

levels. The numbers 1 and 2 Indicate channels 

1 and 2.

6. Simultaneous recording indicator

When 1-slot simultaneous recording is 

configured for the displayed media, a “Sub” 

icon appears on the right of the displayed 

main recording format.

7. Recording format (codec) indicator

Displays the format of the recording on an AXS 

memory card or an SxS memory card 

(page 39).

8. Power supply voltage/Remaining battery 

capacity indicator

Displays the power supply voltage or 

remaining battery capacity.

9. Remaining media capacity indicator

Displays the active media icon, media type, slot 

type (A/B), and remaining recording time 

(when recording in the current recording 

format).

It also displays the clip name during playback.

10. Recording status indicator

Displays the following recording operation 

states of the unit.

Display Description

Stby Recording standby

Rec During recording

11. Thermometer icon

Displayed when a high temperature warning 

message is issued.

The description is displayed in the Info 

category in the menu.
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12. Warning icon

Displayed when other than a high 

temperature warning message is issued.

The description is displayed in the Info 

category in the menu.

13. Ext-LK icon

Displayed when the internal timecode 

generator is locked to an external signal input 

to the TC IN (timecode input) connector.
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Operations on the Home Screen of the Sub Display

Basic Operation

1 Press the HOME button.

The Home screen appears.

Fixed-24 500 90.0
FPS EI Shutter

Reel A001 Shot C004DC IN 15.0V

4K 4:3 2x SV23.98fps

1 2

TCG00:00:00:00

B 180min

A 120 minSxS

REC

1.8
ND WB

3200 03+LookSDI 3/4:

SxS: Log

XAVC QFHD C480 Sub

SxS

2 Select the item to set using the ITEM keys 1 to 

6.

The setting value for items that can be 

changed are displayed in orange.

The following diagram shows an example 

when ITEM key 3 is pressed.

Current:

144.0      

Step Edit

Use buttons or

dial to select.

Step / Cont.

22.5

45.0

90.0

144.0

172.8

(1/59.95 sec)

Set

Cancel

3 Move the cursor to the item or setting value to 

select using the  button (ITEM key 2),  

button (ITEM key 5), or MENU dial.

4 Press the MENU dial or Set button (ITEM key 3) 

to apply the setting.

Changing the brightness of the sub display

You can change the brightness of the sub display 

using Technical > Control Display > Brightness 

level (page 50) in the full menu.

On the Home screen, you can also press and hold 

the BACK button and turn the MENU dial clockwise 

to change the brightness of the sub display in the 

sequence Minimum  Low  Mid  High with 

the current setting as the base point.

You can also press and hold the BACK button and 

turn the MENU dial counterclockwise to change 

the brightness of the sub display in the sequence 

High  Mid  Low  Minimum with the 

current setting as the base point.

[Note]
The display brightness setting is common to both the sub 

display and the mini display, and is reflected on both displays 

simultaneously.

Step Edit Operation

You can change the settings available for selection 

when “Step Edit” is displayed for ITEM key 4 in step 

2 in the basic operation. You can add and delete 

settings on the settings edit screen.

1 On the settings selection screen, move the 

cursor to the setting you want to change or 

delete, and press the Step Edit button (ITEM 

key 4).

The settings edit screen appears.

      Step Edit      

CancelDeleteAdd

Use buttons or

dial to select.

-

90.0

+ 

2 To delete a setting, press the Delete button 

(ITEM key 4).

 [Note]
The selected setting can be deleted if the “Delete” 

character string is displayed in orange.

3 Press the  button (ITEM key 2),  button 

(ITEM key 5), or MENU dial to change a setting.

4 When finished, press the Add button (ITEM key 

4).

The setting is added and the display returns to 

the setting selection screen.

 [Note]
A setting can be added if the “Add” character string is 

displayed in orange.

When setting White Balance

On the White Balance settings edit screen, you 

can press the Coarse/Fine button (ITEM key 1) to 

change the 1-step increment variation to coarse 

or fine. You can also press the Temp/Tint button 

(ITEM key 3) to switch the value between color 

temperature (Temp) and color tone (Tint).

      

Cancel

Coarse / Fine

Use buttons 

or dial to 

select temp.

-

3200K +03

+

Base:

3200 K + 03

Step Edit    

Temp / Tint

DeleteAdd

User Preset
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LUT Operation

Setting a LUT

You can set a LUT for each output system using 

ITEM key 5 on the Home screen.

1 Press ITEM key 5 on the Home screen.

The LUT selection screen appears.

Log

Look Info

Look

SDI 3/4SDI 1/2

HDMIMonitor

s709

Page 1 / 2

Outputs

Edit Look

The LUT selection screen has two pages, and 

you can switch the page by pressing ITEM key 1.

On page 1, you can set the LUT settings for SDI 

1/2 (display only), SDI 3/4, Monitor, and HDMI.

On page 2, you can set the LUT settings for the 

viewfinder, SxS Rec, and Sub Rec.

2 Select the output to set using ITEM keys 2, 3, 5, 

and 6.

The settings edit screen appears.

3 Press the  button (ITEM key 2),  button 

(ITEM key 5), or MENU dial to change a setting.

4 Press the MENU dial or Set button (ITEM key 3) 

to apply the setting.

Changing Preset Look

You can set a LUT when Look is selected on the 

LUT selection screen using the Edit Look button 

(ITEM key 4) on page 1 or page 2.

1 Press the Edit Look button (ITEM key 4) on the 

LUT selection screen.

The Look selection screen appears.

s709

1D-3D-CDL

03: Scene4_Dark_160830

ACS CDL

Process

ACS CDL File

Active

Select

Done

Category

Preset Look

File Info

Load File

Preset look

2 Press the Select button (ITEM key 3).

The items that can be selected are displayed.

3 Press the  button (ITEM key 2),  button 

(ITEM key 5), or MENU dial to change a setting.

4 Press the MENU dial or Set button (ITEM key 3) 

to apply the setting.

Home Screen Items on the Sub Display

The names of items and corresponding setting values are given below.

Default values are shown underlined and in bold text.

Item Description

FPS Displays the video frame rate. The setting is determined by the Project category > 

Project Frame Rate setting (page 36) in the menu.

Project Frame Rate Display

23.98 Fixed-24

24 Fixed-24

25 Fixed-25

29.97 Fixed-30

50 Fixed-50

59.94 Fixed-60

Exposure Index Sets the EI value. The following settings are available.

125EI/160EI/200EI/250EI/320EI/400EI/500EI/640EI/800EI/1000EI/ 

1250EI/1600EI/2000EI

Shutter Sets the electronic shutter angle/shutter speed.

Press the Step/Cont. button (ITEM key 1) to switch between step and continuous 

selection methods.

Step: Select from up to 16 preset values registered as shutter steps. You can press 

the Step Edit button (ITEM key 4) to change any setting from the preset value 

after selection.

Displays the following selection options depending on the Technical > 

System Configuration > Shutter Mode (page 49) setting in the full menu.

Angle: Shutter angle indicator

Default selection options

360/180/172.8/144/90/45/22.5/11.2/5.6

Speed: Shutter speed indicator

Default selection options

1/24, 1/25, 1/30, 1/50, 1/60, 1/100, 1/120, 1/250, 1/500, 1/1000, 1/2000 1)

[Note]
The default speed values for different Project Frame Rate (page 36) settings are 

given below.

23.98/24: 1/24, 25: 1/25, 29.97: 1/30, 50: 1/50, 59.94: 1/60

Cont.: Select an angle/speed within the supported range.
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Item Description

ND Filter Sets the ND filter position. The following settings are available.

Clear/0.3/0.6/0.9/1.2/1.5/1.8/2.1/2.4

LUT Configures settings related to the LUT to apply to the output video.

Page 1

SDI 1/2 (ITEM key 2): Log

Display only, as LUT cannot be applied to the SDI 1/2 output image.

SDI 3/4 (ITEM key 3): Log/Look

Selects the LUT to apply to the SDI 3/4 output image.

Disabled when Monitoring category > Output Format > SDI 1/2 is set to  

4K/QFHD in the menu.

Monitor (ITEM key 5): Log/s709/R709(800%)

Selection becomes Log/Look when Monitoring category > Output Format > 

SDI 1/2 is set to 4K/QFHD in the menu.

HDMI (ITEM key 6): Log/s709/R709(800%)

Fixed to Log when Monitoring category > Output Format > SDI 1/2 is set to 

4K/QFHD and HDMI is set to 4K/QFHD in the menu. In all other cases, the 

options are the same as for Monitor.

Page 2

Viewfinder (ITEM key 2): Log/s709/R709(800%)

Selects the LUT to apply to the viewfinder output image.

SxS Rec (ITEM key 5): Log/Look

Disabled when Project category > SxS Rec Format is set to Rec Off in the 

menu, or fixed to Log when set to XAVC.

Sub Rec (ITEM key 6): Log/Look

Disabled when Project category > SxS Rec Format is set to Rec Off in the 

menu.

Page 1/2 common items

Edit Look: Sets a LUT to apply as a Look.

s709/R709(800%)

WB (White Balance) Sets the color temperature/color tone of the white balance.

Default selection options

3200K+00/4300K+00/5500K+00

You can press the Step Edit button (ITEM key 4) to change the white balance 

preset value and Tint value.

1) The options are 1/60 and subsequent values when the project frame rate is 59.94, 1/50 and subsequent values when 50.0, 

1/30 and subsequent values when 29.97, and 1/25 and subsequent values when 25.0.
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User Functions Screen
You can press the USER button (page 8) to 

display the user functions screen on the sub 

display and use the ITEM keys 1 to 5 as assignable 

buttons (User 1 to 5).

There are also four assignable buttons (pages 

6, 7, 8) to which you can assign various 

functions.

Functions can be assigned to these buttons using 

the user functions screen, in addition to using 

Project > Assignable Button in the full menu.

 ITEM key 4 ITEM key 5 ITEM key 6

ITEM key 3ITEM key 2ITEM key 1

Edit

SDI Frame Line Monitor
Status Info

Monitor
LUT bypass

On On Off

Monitor

Off Auto
Fan Mode

User 1 User 2 User 3

User 4 User 5

STBY 00:00:00:00

Highlight Clip Ind

Changing Button Functions

The user functions selection screen is displayed by 

pressing the Edit button (ITEM key 6) on the user 

functions screen. You can set the functions for the 

User 1 to 5 buttons and assignable buttons 1 to 4 

on the user functions selection screen.

Monitor LUT bypass

Select

Done

SDI Frame Line
Monitor Status Info

Monitor Highlight Clip Ind
Fan Mode
VF Highlight Clip Ind

User 3

User 1
User 2

User 4
User 5

Assign Btn 1

1 On the user functions selection screen, move 

the cursor to the button you want to change, 

and press the Select button (ITEM key 3).

The functions that can be selected are 

displayed.

Set

Cancel

Not Assigned
SDI Frame Line
SDI Status Info
SDI LUT bypass
Monitor Frame Line
Monitor Status Info

<User 1>
SDI Frame Line

2 Press the  button (ITEM key 2),  button 

(ITEM key 5), or MENU dial to change a setting.

3 When finished, press the Set button (ITEM key 

3).

The display returns to the user functions 

screen, and displays the changed function.

The following tables lists the functions that are assigned when the unit is shipped from the factory.

Button Function Assignable Button setting

Assignable 1 Displays clipped highlight areas in red in the 

viewfinder.

VF Highlight Clip Ind

Assignable 2 No assignment Not Assigned

Assignable 3 No assignment Not Assigned

Assignable 4 No assignment Not Assigned

ITEM key 1 No assignment Not Assigned

ITEM key 2 No assignment Not Assigned

ITEM key 3 No assignment Not Assigned

ITEM key 4 Displays clipped highlight areas in red on the 

Monitor output.

Monitor Highlight Clip Ind

ITEM key 5 Sets the fan control mode. Fan Mode

Functions that can be Assigned to ITEM Keys 1 to 5

Assignable Button 

setting

Function State when unit is powered on

Not Assigned No assignment –

SDI Frame Line Turns superimposition of frame lines on the SDI 

3/4 output image on/off.

Setting retained

SDI Status Info Turns display of information on the SDI 3/4 output 

image on/off.

Setting retained

SDI LUT bypass Disables the LUT applied to the SDI 3/4 output 

image while the key is pressed, and sets Log 

image quality without applying a LUT.

Setting not retained

Monitor Highlight Clip 

Ind

Turns the function that displays clipped highlight 

areas in red on the Monitor output image on/off.

Setting retained

Monitor Frame Line Turns superimposition of frame lines on the 

Monitor output image on/off.

Setting retained

Monitor Status Info Turns display of information on the Monitor 

output image on/off.

Setting retained

Monitor LUT bypass Disables the LUT applied to the Monitor output 

image while the button is pressed, and sets Log 

image quality without applying a LUT.

Setting not retained

Color Bars Turns color bars on/off. Setting retained

AXS Slot Change Switches the active slot when two AXS memory 

cards are inserted.

Switches between A and B each time the key is 

pressed.

Setting retained
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Assignable Button 

setting

Function State when unit is powered on

SxS Slot Change Switches the active slot when two SxS memory 

cards are inserted.

Switches between A and B each time the key is 

pressed.

Setting retained

Fan Mode Sets the fan control mode.

Switches between Auto  Max  Off in Rec/

Auto  Off in Rec/Max each time the key is 

pressed.

Setting retained

Format Media AXS  

Slot A

Formats media in AXS slot A. –

Format Media AXS  

Slot B

Formats media in AXS slot B. –

Format Media SxS  

Slot A

Formats media in SxS slot A. –

Format Media SxS  

Slot B

Formats media in SxS slot B. –

APR Executes APR. –

Lens Interface Selects the lens interface.

Switches between Off  Type C each time the 

key is pressed.

Setting retained

VF Highlight Clip Ind Turns the function to display clipped highlight 

areas in red in the viewfinder on/off.

Setting retained

Functions that can be Assigned to Assignable Buttons 1 to 4

Assignable Button setting Function State when unit is powered on

Not Assigned No assignment –

SDI Frame Line Turns superimposition of frame lines 

on the SDI 3/4 output image on/off.

Setting retained

SDI Status Info Turns display of information on the 

SDI 3/4 output image on/off.

Setting retained

SDI LUT bypass Disables the LUT applied to the SDI 

3/4 output image while the button is 

pressed, and sets Log image quality 

without applying a LUT.

Setting not retained

Monitor Frame Line Turns superimposition of frame lines 

on the Monitor output image on/off.

Setting retained

Monitor Status Info Turns display of information on the 

Monitor output image on/off.

Setting retained

Monitor LUT bypass Disables the LUT applied to the 

Monitor output image while the 

button is pressed, and sets Log 

image quality without applying a 

LUT.

Setting not retained

Monitor Highlight Clip Ind Turns the function that displays 

clipped highlight areas in red on the 

Monitor output image on/off.

Setting retained

Color Bars Turns color bars on/off. Setting retained

AXS Slot Change Switches the active slot when two 

AXS memory cards are inserted.

Switches between A and B each time 

the button is pressed.

–

SxS Slot Change Switches the active slot when two 

SxS memory cards are inserted.

Switches between A and B each time 

the button is pressed.

–

Rec Review Executes the Rec Review function. Setting not retained

VF Frame Line Turns superimposition of frame lines 

on the viewfinder output image on/

off.

Setting retained

VF Zebra Turns the zebra function of the 

viewfinder output image on/off.

Setting retained

VF Status Info Turns the information display on the 

viewfinder output image on/off.

Setting retained
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Assignable Button setting Function State when unit is powered on

VF Focus Magnifier Turns the focus magnifier function of 

the viewfinder on/off.

Setting not retained

VF LUT bypass Disables the LUT applied to the 

viewfinder output image while the 

button is pressed, and sets Log 

image quality without applying a 

LUT.

Setting not retained

VF Highlight Clip Ind Turns the function to display clipped 

highlight areas in red in the 

viewfinder on/off.

Setting retained
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Menu Operations
By pressing the MENU button while shooting 

(during recording or recording standby) or during 

playback, you can display and operate the menu 

screen on the sub display.

ˎˎ Project category: Basic settings and recording 

format settings

ˎˎ TC/Media category: Timecode value and TC 

format settings

ˎˎ Monitoring category: SDI/HDMI/Monitor 

external signal output format, OSD, and marker 

overlay status settings

ˎˎ Audio category: Audio source and audio level 

settings

ˎˎ Info category: Camera, media, and battery status 

information

Controls

MENU button (page 7)
Press to display the menu on the sub display.

ITEM keys 1 to 6 (page 7)
Selects the category of the menu.

SEL/SET dial (MENU dial) (page 7)
Turn to move the cursor in the corresponding 

direction to select setting items or setting values.

Press the MENU dial to apply the selected item.

BACK button (page 8)
Press to return to the previous menu. Unconfirmed 

changes are canceled.

Basic Operation

1 Press the MENU button.

The menu screen appears.

2 Select the category to set using ITEM keys 1 to 

6.

3 Turn the MENU dial to move the cursor to the 

setting item to select.

For each setting item, the setting value is 

displayed.

“Menu Item List” (page 36)

MonitoringProject TC/Media

Audio Info

Imager Mode

Project Frame Rate

Input Color Space

AXS Rec Format

SxS Rec Format

Sub Rec Format 

Project Details > 

23.98

S-Gamut3.Cine/Slog3

Rec Off

XAVC 4K Class300

Rec Off

4K 17:9

4 Press the MENU dial.

The setting value selection screen appears 

next to the selected item.

MonitoringProject TC/Media

Audio Info

Imager Mode

Project Frame Rate

Input Color Space

AXS Rec Format

SxS Rec Format

Sub Rec Format

Project Details > 

4K 4:3

4K 17:9

3.8K 16:9

Rec Off

XAVC 4K Class300

Rec Off

5 Turn the MENU dial to move the cursor to the 

setting value.

6 Press the MENU dial to apply the setting.
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Menu Item List

The items available in each category are given below.

Project category

Default values are shown underlined and in bold text.

Item Settings Description

Imager Mode 6K 3:2/4K 4:3/4K 17:9/3.8K 16:9 Sets the effective picture size.

[Notes]

ˎˎ “6K 3:2” and “4K 4:3” are displayed only when a 

license is installed.

ˎˎ Clips recorded in 6K 3:2 cannot be played back on 

the unit.

Project Frame Rate 23.98/24/25/29.97/50/59.94 Sets the project frame rate.

Input Color Space S-Gamut3.Cine/Slog3 Sets the color space. Fixed to S-Gamut3.Cine/

Slog3 in firmware version 1.0.

AXS Rec Format 1)

(Only when an AXS-R7 is 

attached)

Rec Off/RAW SQ/X-OCN 

ST/X-OCN LT

Sets the recording format for AXS memory cards 

when an AXS-R7 is connected.

SxS Rec Format 1) Rec Off/XAVC 4K Class480/

XAVC 4K Class300/XAVC 

QFHD Class480/XAVC QFHD 

Class300/MPEG HD P/ 

MPEG HD i

Sets the main recording format for SxS memory 

cards.

Sub Rec Format 1) Rec Off/MPEG HD P/ 

MPEG HD i

Sets the sub recording format for SxS memory 

cards.

Project Details

(ITEM key 6)

Displays the contents of the Project menu 

(page 43) in the full menu.

1) The recording formats available vary depending on the combination of the effective picture size and project frame rate 

settings. For details about settings, see “Recording Format Settings” (page 39).

TC/Media category

Default values are shown underlined and in bold text.

Item Settings Description

TC Mode Preset F-Run (Ext-Lk)/ 

Preset R-Run/Int Regen

Sets the timecode mode.

Preset F-Run (Ext-Lk): Timecode 

advances continuously from specified 

value, regardless of whether recording or 

not.

Preset R-Run: Timecode advances from 

specified value only when recording.

Int Regen: Timecode continues from that 

of the previous clip.

TC Display Timecode/Duration Switches the time data indication.

TC Setting

(set when switching 

to another screen)

Setting 

(H, M, S, F)

Sets the timecode to a desired value.

Reset Resets the timecode to 00:00:00:00.

TC Format DF/NDF Sets the timecode format.

DF: Drop frame

NDF: Non drop frame

TC Source Internal/External Display only.

Cam ID A to Z Sets the camera ID used when 

generating clip names.

Clip name: Camera ID + Reel Number + 

Shot Number + date + random string

Reel# 001 to 999 Sets the numeric portion of the Reel 

Number used when generating clip 

names.

Clip name: Camera ID + Reel Number + 

Shot Number + date + random string

Camera Position C/L/R Sets the first character portion of the 

Shot Number used when generating clip 

names.

Clip name: Camera ID + Reel Number + 

Shot Number + date + random string
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Item Settings Description

Format Media

(executed when 

switching to another 

screen)

AXS Slot A Formats the AXS memory card in slot A.

AXS Slot B Formats the AXS memory card in slot B.

SxS Slot A Formats the SxS memory card in slot A.

SxS Slot B Formats the SxS memory card in slot B.

SD Card Formats the SD card.

Media Details

(ITEM key 6)

Displays the contents of the TC/Media 

menu (page 44) in the full menu.

Monitoring category

Default values are shown underlined and in bold text.

[Notes]

ˎˎ The unit supports independent configuration of Info and Frame Line for each system. The display information for the A and 

B output images is configured using the Monitoring menu (page 45).

ˎˎ Info and Frame Line may not be displayed depending on the Output Format setting. In this case, “–” is displayed and the 

setting cannot be changed.

Item Settings Description

VF Info A/B/Off Selects the information to display 

superimposed on the viewfinder image.

Frame Line A/B/Off Selects the frame lines to display 

superimposed on the viewfinder image.

SDI 1/2 Output 

Format

The available settings vary 

according to the imager 

mode, project frame rate, and 

SxS recording format settings.

Selects the SDI 1/2 output format. 1)

Info – Information display is not superimposed 

on the SDI 1/2 output.

Frame Line A/B/Off Selects the frame lines to display 

superimposed on the SDI 1/2 output.

[Note]
Frame lines are only superimposed if the 

output format is 4K/QFHD.

Item Settings Description

SDI 3/4

[Note]
Depending on the 

Output Format setting 

of SDI 1/2, the Output 

Format, Info, Frame 

Line settings of SDI 

3/4 may be blank and 

cannot be changed.

Output 

Format

The available settings vary 

depending on the SDI 1/2 

setting.

Selects the SDI 3/4 output format. 1)

Info A/B/Off Selects the information to display 

superimposed on the SDI 3/4 output.

Frame Line A/B/Off Selects the frame lines to display 

superimposed on the SDI 3/4 output.

Monitor Output 

Format

The available settings vary 

depending on the SDI 1/2 

setting.

Selects the Monitor output format. 2)

Info A/B/Off Selects the information to display 

superimposed on the Monitor output.

Frame Line A/B/Off Selects the frame lines to display 

superimposed on the Monitor output.

HDMI Output 

Format

The available settings vary 

depending on the SDI 1/2 

setting.

Selects the HDMI output format. 2)

Moni. Details

(ITEM key 6)

Displays the contents of the Monitoring 

menu (page 45) in the full menu.

1) For details about formats available for selection, see “SDI OUT Connector Output Formats” (page 64).
2) For details about formats available for selection, see “MONITOR OUT Connector/HDMI OUT Connector Output Formats” 

(page 66).
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Audio category

Default values are shown underlined and in bold text.

Item Settings Description

Source Switch LINE / AES/EBU / MIC Displays the position of the AUDIO IN switch 

(page 7) that sets the CH1 and CH2 input 

source.

CH-1 Audio Level Auto/Manual

–99 to ±0 to +99

The audio recording level is adjusted 

automatically when set to Auto.

The audio recording level is adjusted manually 

when set to Manual.

CH-2 Audio Level Auto/Manual

–99 to ±0 to +99

The audio recording level is adjusted 

automatically when set to Auto.

The audio recording level is adjusted manually 

when set to Manual.

MIC Reference –60dB/–50dB/–40dB Selects the reference input level of the 

microphone.

Monitor CH When Monitor Output CH Pair 

is set to CH-1/CH-2

CH-1/CH-2, CH-1, CH-2

When Monitor Output CH Pair 

is set to CH-3/CH-4

CH-3/CH-4, CH-3, CH-4

Selects the audio channel that is output to the 

headphones and speaker.

Monitor Level 0 to 99 Adjusts the monitor audio level.

CH1 Level Meter – Displays the CH1 level meter.

CH2 Level Meter – Displays the CH2 level meter.

CH3 Level Meter – Displays the CH3 level meter.

CH4 Level Meter – Displays the CH4 level meter.

Audio Details  

(ITEM key 6)

Displays the contents of the Audio menu 

(page 48) in the full menu.

Checking the Status using the Info Category

You can check the status of media and the battery, and check the contents of warnings and errors that 

are issued using the Info category. The contents of the display update in realtime as the status of the unit 

changes.

The Info category consists of the following six information pages. Turn the MENU dial  to switch the page.

No. Page Description

1 Camera Condition Displays warning messages and error messages. When there are 

no messages, “All Systems are OK” is displayed at the top of the 

display area.

2 Firmware Displays the firmware version of the unit, the serial number and 

firmware version of the AXS-R7 attached to the unit, and the 

name and validity of option software licenses on the unit. If an 

option is not added or currently valid, “Not Installed” or “Expired” 

is displayed.

3 System Displays the following system information.

ˎˎ Date and time

ˎˎ Fan rotation speed

ˎˎ Sensor detection temperature

ˎˎ Hours meter

ˎˎ IP Address

4 Battery Displays the following battery information.

ˎˎ Detected battery name or type

ˎˎ Remaining capacity (%)

ˎˎ Estimated remaining time

ˎˎ Remaining capacity (Ah)

ˎˎ Voltage (V)

ˎˎ Number of times that the battery has been charged

ˎˎ Power source

ˎˎ Supplied power source voltage

5 Media Displays the remaining capacity, remaining recording time, and 

lifespan data of SxS memory cards, AXS memory cards (when 

AXS-R7 is attached), and SD cards.

6 Lens Displays the following information for the lens attached to the 

unit.

ˎˎ Lens model name

ˎˎ T value of iris

ˎˎ Focal length

ˎˎ Focus distance

ˎˎ Depth of field

ˎˎ Serial number
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Recording Format Settings

The following recording formats can be selected for different combinations of effective picture size and 

project frame rate settings.

If a value shown underlined and in bold text is selected, a LUT setting can be applied to the recorded 

video signal.

Project Frame Rate Effective picture 

size (Imager Mode)

Main recording format SxS sub recording 

format (Sub Rec 

Format)
AXS Rec Format SxS Rec Format

23.98 4K 17:9

(4096×2160)

Off Off –

4K XAVC-I Class480 Off

MPEG HD422 1)

4K XAVC-I Class300 Off

MPEG HD422 1)

RAW/X-OCN 

ST/X-OCN LT  

Off –

MPEG HD422 1) –

3.8K 16:9

(3840×2160)

Off Off Off

QFHD XAVC-I 

Class480

Off

MPEG HD422

QFHD XAVC-I 

Class300

Off

MPEG HD422

MPEG HD422 –

RAW/X-OCN 

ST/X-OCN LT

Off –

MPEG HD422 –

4K 4:3

Anamorphic

(4096×3024)

Off Off Off

X-OCN ST/X-OCN LT Off –

MPEG HD422 1) –

6K 3:2 (6048×4032) Off Off Off

X-OCN ST/X-OCN LT Off Off

Project Frame Rate Effective picture 

size (Imager Mode)

Main recording format SxS sub recording 

format (Sub Rec 

Format)
AXS Rec Format SxS Rec Format

24 4K 17:9

(4096×2160)

Off Off –

4K XAVC-I Class480 Off

4K XAVC-I Class300 Off

RAW/X-OCN 

ST/X-OCN LT

Off –

3.8K 16:9 

(3840×2160)

Off Off Off

RAW/X-OCN 

ST/X-OCN LT

Off –

4K 4:3

Anamorphic

(4096×3024)

Off Off Off

X-OCN ST/X-OCN LT Off –

6K 3:2 (6048×4032) Off Off Off

X-OCN ST/X-OCN LT Off Off

25/29.97 4K 17:9

(4096×2160)

Off Off –

4K XAVC-I Class480 Off

MPEG HD422 1)

4K XAVC-I Class300 Off

MPEG HD422 1)

RAW/X-OCN 

ST/X-OCN LT

Off –

MPEG HD422 1) –

3.8K 16:9

(3840×2160)

Off Off Off

QFHD XAVC-I 

Class480

Off

MPEG HD422

QFHD XAVC-I 

Class300

Off

MPEG HD422

MPEG HD422 –

RAW/X-OCN 

ST/X-OCN LT

Off –

MPEG HD422 –
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Project Frame Rate Effective picture 

size (Imager Mode)

Main recording format SxS sub recording 

format (Sub Rec 

Format)
AXS Rec Format SxS Rec Format

50/59.94 4K 17:9

(4096×2160)

Off Off –

4K XAVC-I Class300 Off

MPEG HD422 1)

RAW/X-OCN 

ST/X-OCN LT

Off –

MPEG HD422 1) –

3.8K 16:9

(3840×2160)

Off Off Off

QFHD XAVC-I 

Class300

Off

MPEG HD422

MPEG HD422 –

RAW/X-OCN 

ST/X-OCN LT

Off –

MPEG HD422 –

1) Horizontal frame with black bars across top and bottom (letterboxing).
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Full Menu Operations
The full menu for configuring the required settings 

for shooting and playback is displayed on the sub 

display be pressing and holding the MENU button 

for 2 seconds or longer.

Menu Structure

Shooting menu

Menu used to make settings related to shooting.

Project menu

Menu used to make basic settings for a project.

TC/Media menu

Menu used to make settings related to timecode 

and recording media.

Monitoring menu

Menu used to make settings related to video 

output and viewfinder output.

Audio menu

Menu used to make settings related to audio.

Technical menu

Menu used to make settings related to technical 

matters.

Maintenance menu

Menu used to make unit settings, such as the clock 

and language settings.

Controls

MENU button (page 7)
Press and hold for 2 seconds or longer to display 

the full menu on the sub display.

SEL/SET dial (MENU dial) (page 7)
Turn to move the cursor in the corresponding 

direction to select setting items or setting values.

Press the MENU dial to apply the selected item.

BACK button (page 8)
Press to return to the previous menu. Unconfirmed 

changes are canceled.

Setting Menu Items

Turn the MENU dial to move the cursor to the 

menu item you want to set, then press the MENU 

dial to select that item.

ˎˎ The menu item selection area can show a 

maximum of nine lines. When all the selectable 

items cannot be displayed at one time, you can 

scroll the display up or down by moving the 

cursor.

ˎˎ For items having a wide range of available 

values (example: –99 to +99), the selection 

area is not displayed. The current setting is 

highlighted to indicate that the value can be 

changed.

ˎˎ If you select Execute for an executable item, the 

corresponding function is executed.

ˎˎ When you select an item that you must confirm 

before execution, a confirmation message 

appears. Follow the instructions in the message 

to execute or cancel the operation.
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Full Menu List
The functions and available settings of each menu item are given below.

Shooting Menu

Default values are shown underlined and in bold text.

Shooting > Shutter

Makes settings related to the electronic shutter.

Menu item Settings Description

Shutter Select When Shutter Mode (page 49) 

is set to Speed

Default selection options

1/24, 1/25, 1/30, 1/50, 1/60, 

1/100, 1/120, 1/250, 1/500, 

1/1000, 1/2000 1)

When Shutter Mode (page 49) 

is set to Angle

Default selection options

360.0/180.0/172.8/144.0/ 

90.0/45.0/22.5/11.2/5.6

When Step/Cont. Select is set to 

Continuous, the selection range 

is 360.0 to 4.2 (Angle) or 1/241) to 

1/80002) (Speed).

Selects shutter angle or speed of the electronic 

shutter.

The default speed values for different Project 

Frame Rate (page 43) settings are given below.

23.98/24: 1/24

25: 1/25

29.97: 1/30

50: 1/50

59.94: 1/60

Step/Cont. Select Step/Continuous Selects whether the electronic shutter values are 

step values or continuous.

Add/Change Step Adds or edits a selection option available in 

Shutter Select in Step mode.

Up to 16 selection options can be added.

Delete Step Deletes a selection option available in Shutter 

Select in Step mode.

Shooting > ND

Sets the ND filter position.

Menu item Settings Description

ND Position Clear/0.3/0.6/0.9/1.2/1.5/1.8/ 

2.1/2.4

Selects the density of the ND filter.

Shooting > Exposure Index

Sets the EI value.

Menu item Settings Description

EI Select 125EI/160EI/200EI/250EI/320EI/ 

400EI/500EI/640EI/800EI/1000EI/ 

1250EI/1600EI/2000E

Selects the EI value.

Shooting > White Balance

Makes settings related to white balance.

Menu item Settings Description

Color Temp. Select 3200K+00/4300K+00/ 

5500K+00

+ other added options (up to 16)

Displays and selects the color temperature/color 

tone of the white balance.

Add/Change Step Adds or edits a selection option by changing the 

color temperature and tint value of white balance.

Delete Step Deletes an added selection option.

Shooting > LUT Select

Makes settings related to the LUT to apply to the output image.

Menu item Settings Description

SDI 1/2 Log Display only, as LUT cannot be applied to the SDI 

1/2 output image.

SDI 3/4 Log/Look/--- Selects the LUT to apply to the SDI 3/4 output 

image.

Monitor Log/s709/R709(800%)/Look/---

The default values are given 

below.

When Output Format >  

SDI 1/2 is 2K/HD: s709

When Output Format >  

SDI 1/2 is 4K/QFHD: Look

Selects the LUT to apply to the Monitor output 

image.

HDMI Log/s709/R709(800%)/Look

The default values are given 

below.

When Output Format >  

SDI 1/2 is 2K/HD: s709

When Output Format >  

SDI 1/2 is 4K/QFHD and 

HDMI is not 4K/QFHD: Look

When Output Format > 

HDMI is 4K/QFHD: Log

Displays the LUT to apply to HDMI output image.

VF LUT Log/s709/R709(800%) Selects the LUT to apply to the viewfinder output 

image.

SxS Rec Log/Look/--- Selects the LUT to apply to SDI Main clip recorded 

video.

Sub Rec Log/Look/--- Selects the LUT to apply to SDI Sub clip recorded 

video.
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Shooting > Look

Makes settings related to Preset Look.

Menu item Settings Description

Category Preset Look Displays the LUT category.

Preset Look Select s709/R709(800%) Selects the Preset Look.

Outputs images that are suitable as the starting 

point for color grading or images that are close to 

print film quality.

s709: Cinema color

R709(800%): Faithful color

1) The options are 1/60 and subsequent values when the project frame rate is 59.94, 1/50 and subsequent values when 50.0, 

1/30 and subsequent values when 29.97, and 1/25 and subsequent values when 25.0.
2) The options are 1/7000 and preceding values when the project frame rate is 50.0 or 25.0, and 1/6000 and preceding values 

when 24.0 or 23.98.

Project Menu

Default values are shown underlined and in bold text.

Project > Basic Setting

Makes settings related to picture size and project frame rate.

Menu item Settings Description

Imager Mode 6K 3:2/4K 4:3/4K 17:9/3.8K 16:9 Selects the effective picture size.

[Notes]

ˎˎ “6K 3:2” and “4K 4:3” are displayed only when a license 

is installed.

ˎˎ Clips recorded in 6K 3:2 cannot be played back on 

the unit.

Project Frame Rate 23.98/24/25/29.97/50/59.94 Selects the project frame rate.

AXS Rec Format

(Only when an AXS-R7 

is attached)

Rec Off/RAW SQ/X-OCN ST/ 

X-OCN LT

Selects the video format for recording onto an 

AXS memory card inserted into an AXS-R7.

SxS Rec Format Rec Off/XAVC 4K Class480/ 

XAVC 4K Class300/XAVC QFHD 

Class480/XAVC QFHD Class300/

MPEG HD P/MPEG HD i

Selects the video format to be recorded on an SxS 

memory card.

Sub Rec Format Rec Off/MPEG HD P/MPEG HD i Selects the sub recording format for SxS memory 

cards.

SxS/Output  

De-Squeeze

×2.0 Displays the de-squeeze process status for SxS 

recording signals and video output signals.

Displayed only when Imager Mode is set to 4K 4:3.

Project > Assignable Button

Assigns functions to assignable buttons.

For details about assigning functions, see “User Functions Screen” (page 32).

Menu item Settings Description

<1> page 32 Assigns a function to assignable button 1.

<2> page 32 Assigns a function to assignable button 2.

<3> page 32 Assigns a function to assignable button 3.

<4> page 32 Assigns a function to assignable button 4.

<User 1> page 32 Assigns a function to ITEM key 1.

<User 2> page 32 Assigns a function to ITEM key 2.

<User 3> page 32 Assigns a function to ITEM key 3.

<User 4> page 32 Assigns a function to ITEM key 4.

<User 5> page 32 Assigns a function to ITEM key 5.
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Project > All File

Makes settings related to All-settings files.

Menu item Settings Description

Load SD Card Load an All-settings file from an SD card.

Save SD Card Save an All-settings file on an SD card.

File ID Displays the file ID of the All-settings file for 

editing.

Format SD Card Formats an SD card.

TC/Media Menu

Default values are shown underlined and in bold text.

TC/Media > Timecode

Makes settings related to timecode.

Menu item Settings Description

Mode Preset F-Run (Ext-Lk)/ 

Preset R-Run/Int Regen

Selects the timecode mode.

Preset F-Run (Ext-Lk): Timecode advances 

continuously from specified value, in sync 

with external input timecode.

Preset R-Run: Timecode advances from specified 

value only when recording.

Int Regen: Timecode continues from that of the 

previous clip.

Manual Setting 00:00:00:00 to 23:59:59:29 Sets an arbitrary timecode value.

Reset Execute/Cancel Resets the timecode to 00:00:00:00 (execute by 

selecting Execute).

TC Format DF/NDF Selects the timecode format.

DF: Drop frame

NDF: Non drop frame

TC Source Internal/External Displays the TCG sync source.

Time Data Display Timecode/Duration Selects the time data to display.

TC/Media > Clip Name Format

Sets clip names. (Clip name: Camera ID + Reel Number + Shot Number + date + random string)

Menu item Settings Description

Camera ID A to Z Sets the camera ID used when generating clip 

names.

Reel Number 001 to 999 Sets the numeric portion of the Reel Number 

used when generating clip names.

Camera Position C/L/R Sets the first character portion of the Shot 

Number used when generating clip names.

TC/Media > Format Media

Formats media.

Menu item Settings Description

AXS Slot A

(Only when an AXS-R7 

is attached)

Execute/Cancel Initializes the AXS memory card in slot A (execute 

by selecting Execute).

AXS Slot B

(Only when an AXS-R7 

is attached)

Execute/Cancel Initializes the AXS memory card in slot B (execute 

by selecting Execute).
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TC/Media > Format Media

Formats media.

Menu item Settings Description

SxS Slot A Execute/Cancel Initializes the SxS memory card in slot A (execute 

by selecting Execute).

SxS Slot B Execute/Cancel Initializes the SxS memory card in slot B (execute 

by selecting Execute).

SD Card Execute/Cancel Formats the SD card (execute by selecting 

Execute).

TC/Media > Update Media

Updates the media’s management file.

Menu item Settings Description

AXS Slot A

(Only when an AXS-R7 

is attached)

Execute/Cancel Updates the management file on the AXS 

memory card in slot A of the AXS recorder 

(execute by selecting Execute).

AXS Slot B

(Only when an AXS-R7 

is attached)

Execute/Cancel Updates the management file on the AXS 

memory card in slot B of the AXS recorder 

(execute by selecting Execute).

SxS Slot A Execute/Cancel Updates the management file on the SxS memory 

card in slot A (execute by selecting Execute).

SxS Slot B Execute/Cancel Updates the management file on the SxS memory 

card in slot B (execute by selecting Execute).

Monitoring Menu

Default values are shown underlined and in bold text.

Monitoring > Output Format

Makes settings related to output format.

Menu item Settings Description

SDI 1/2 The available settings vary 

according to the imager mode, 

project frame rate, and SxS 

recording format settings.

Selects the SDI 1/2 output format.

Settings vary according to the recording format 

(page 64).

SDI 3/4 The available settings vary 

depending on the SDI 1/2 

setting.

Selects the SDI 3/4 output format.

Settings vary according to the recording format 

(page 64).

Monitor The available settings vary 

depending on the SDI 1/2 

setting.

Selects the Monitor output format.

Settings vary according to the recording format 

(page 66).

HDMI The available settings vary 

depending on the SDI 1/2 

setting.

Selects the HDMI output format.

Settings vary according to the recording format 

(page 66).

Monitoring > VF OSD

Makes settings related to information and frame lines superimposed on the viewfinder output signal.

Menu item Settings Description

Status Info On/Off Turns the function to superimpose information on 

the viewfinder output signal on/off.

Status Info Select Info. A/Info. B Selects the information to display superimposed 

on the viewfinder output signal.

Frame Line On/Off Turns the function to superimpose frame lines on 

the viewfinder output signal on/off.

Frame Line Select Frame Line A/Frame Line B Selects the frame lines to display superimposed 

on the viewfinder output signal.

Monitoring > SDI OSD

Makes settings related to information and frame lines superimposed on the SDI output signal.

Menu item Settings Description

Status Info On/Off Turns the function to superimpose information on 

the SDI 3/4 output signal on/off.

Status Info Select Info. A/Info. B Selects the information to display superimposed 

on the SDI 3/4 output signal.

Frame Line On/Off Turns the function to superimpose frame lines on 

the SDI 3/4 output signal on/off.
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Monitoring > SDI OSD

Makes settings related to information and frame lines superimposed on the SDI output signal.

Menu item Settings Description

Frame Line Select Frame Line A/Frame Line B Selects the frame lines to display superimposed 

on the SDI 3/4 output signal.

Monitoring > Monitor OSD

Makes settings related to information and frame lines superimposed on the Monitor/HDMI output signal.

Menu item Settings Description

Status Info On/Off Turns the function to superimpose information on 

the Monitor/HDMI output signal on/off.

Status Info Select Info. A/Info. B Selects the information to display superimposed 

on the Monitor/HDMI output signal.

Frame Line On/Off Turns the function to superimpose frame lines on 

the Monitor/HDMI output signal on/off.

Frame Line Select Frame Line A/Frame Line B Selects the frame lines to display superimposed 

on the Monitor/HDMI output signal.

Monitoring > HDMI OSD

Makes settings related to information superimposed on the HDMI output signal.

Menu item Settings Description

OSD Status Same as SDI/Same as Monitor Selects whether the information displayed 

superimposed on the HDMI output signal is the 

same as for the SDI output signal or Monitor 

output signal.

Monitoring > Status Info A

Makes settings related to information displayed on the output image when Status Info Select is set to 

“Info. A” for each OSD menu item.

Menu item Settings Description

Project On/Off Turns the project information display on/off.

Timecode On/Off Turns the timecode information display on/off.

Audio Level Meter On/Off Turns the audio level meter indicators on/off.

Look Status On/Off Turns the Look type indicator on/off.

Output LUT On/Off Turns the output LUT information display on/off.

Recording LUT On/Off Turns the recording LUT information display on/

off.

VF Status On/Off Turns the viewfinder status indicator on/off.

Lens Status On/Off Turns the lens information display on/off.

Monitoring > Status Info B

Makes settings related to information displayed on the output image when Status Info Select is set to 

“Info. B” for each OSD menu item.

Menu item Settings Description

Project On/Off Turns the project information display on/off.

Timecode On/Off Turns the timecode information display on/off.

Audio Level Meter On/Off Turns the audio level meter indicators on/off.

Look Status On/Off Turns the Look type indicator on/off.

Output LUT On/Off Turns the output LUT information display on/off.

Recording LUT On/Off Turns the recording LUT information display on/

off.

VF Status On/Off Turns the viewfinder status indicator on/off.

Lens Status On/Off Turns the lens information display on/off.

Monitoring > Display Info

Makes settings related to focus position display units.

Menu item Settings Description

Focus Distance Format Meter/Feet Selects the focus position display units.

Monitoring > Frame Line A

Makes settings related to information displayed on the output image when Frame Line is set to Frame 

Line A for each OSD menu item.

Menu item Settings Description

Center Marker On/Off Turns the center marker on/off.

Aspect Ratio On/Off Turns the aspect marker on/off.

Aspect Safety Zone On/Off Turns the aspect safety zone marker on/off.

Picture Area On/Off Turns the picture area indicator on/off.

Safety Zone On/Off Turns the safety zone indicator on/off.

User Frame Line On/Off Turns the user frame lines indicator on/off.

Monitoring > Frame Line B

Makes settings related to information displayed on the output image when Frame Line is set to Frame 

Line B for each OSD menu item.

Menu item Settings Description

Center Marker On/Off Turns the center marker on/off.

Aspect Ratio On/Off Turns the aspect marker on/off.

Aspect Safety Zone On/Off Turns the aspect safety zone marker on/off.

Picture Area On/Off Turns the picture area indicator on/off.

Safety Zone On/Off Turns the safety zone indicator on/off.

User Frame Line On/Off Turns the user frame lines indicator on/off.
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Monitoring > Frame Line

Makes settings related to lines and markers displayed on the output image.

Menu item Settings Description

Color White/Yellow/Cyan/Green/

Magenta/Red/Blue

Selects the display color of frame lines.

Center Marker Cross/Open Cross/Dot Selects the display form of the center marker.

Safety Area 80%/90%/92.5%/95% Selects the safety zone range.

Aspect Ratio Type Line/Mask Select the display form of the aspect marker.

Line: Displays lines with color set by Color.

Mask: Displays a lower video signal level for areas 

outside the marker area.

Aspect Ratio Select 17:9/16:9/15:9/14:9/13:9/4:3/ 

1.66:1/1.85:1/2.35:1/2.39:1

Selects the mode when displaying the aspect 

marker.

Aspect Ratio Mask 0 to 15 (12) Selects the brightness of the image outside the 

aspect marker when Aspect Ratio Type is set to 

Mask.

Aspect Safety Area 80%/90%/92.5%/95% Selects the size (percentage of the entire screen) 

of the aspect safety zone marker.

Frame Line on 

Playback

On/Off Turns the function to superimpose frame lines 

during playback on/off.

Monitoring > User Frame Line

Makes settings related to the user frame lines.

Menu item Settings Description

Width 3 to 479 (240) Sets the user frame line width (distance from the 

center to the left and right edges).

Height 3 to 269 (135) Sets the user frame line height (distance from the 

center to the top and bottom edges).

H Position Max. –476 to 476 (±0) Sets the horizontal position of the center of the 

user frame lines.

The setting range becomes narrower as the Width 

setting increases above 3.

V Position Max. –266 to 266 (±0) Sets the vertical position of the center of the user 

frame lines.

The setting range becomes narrower as the 

Height setting increases above 3.

Monitoring > VF Display

Makes settings related to the viewfinder display.

Menu item Settings Description

VF LUT Log/s709/R709(800%) Selects the LUT to apply to the viewfinder output 

image.

Status Info On/Off Turns the function to superimpose information on 

the viewfinder output image on/off.

Monitoring > VF Display

Makes settings related to the viewfinder display.

Menu item Settings Description

Status Info Select Info. A/Info. B Selects the information to display superimposed 

on the viewfinder output image.

Frame Line On/Off Turns the function to superimpose frame lines on 

the viewfinder output image on/off.

Frame Line Select Frame Line A/Frame Line B Selects the frame lines to display superimposed 

on the viewfinder output image.

Color –99 to ±0 to +99 Adjusts the color depth of the viewfinder image.

Monitoring > VF Function

Makes settings related to viewfinder functions.

Menu item Settings Description

Double Speed Scan On/Off Turns the viewfinder double speed scan function 

on/off.

Peaking Frequency Normal/High Selects whether the peaking frequency is normal 

or high during peaking.

Zebra On/Off Turns the zebra function on/off.

Zebra Select 1/2/Both Selects the zebra pattern type (Zebra 1, Zebra 2, 

Both).

Zebra1 Level 0% to 107% (41%) Sets the display level of zebra 1.

Zebra1 Aperture Level 1% to 20% (10%) Sets the aperture level of zebra 1.

Zebra2 Level 0% to 109% (61%) Sets the display level of zebra 2.
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Audio Menu

Default values are shown underlined and in bold text.

Audio > Audio Input

Makes settings related to audio recording levels.

[Note]
The audio recording level with AES/EBU signal selected is fixed.

Menu item Settings Description

CH-1 Audio Select Auto/Manual Automatically adjusts the audio recording when 

set to Auto.

CH-2 Audio Select Auto/Manual Automatically adjusts the audio recording when 

set to Auto.

CH-1 Audio Level –99 to ±0 to +99 Adjusts the audio recording level when CH-1 

Audio Select is set to Manual.

CH-2 Audio Level –99 to ±0 to +99 Adjusts the audio recording level when CH-2 

Audio Select is set to Manual.

MIC Reference –60dB/–50dB/–40dB Selects the reference input level of the 

microphone.

Audio > Audio Monitor

Makes settings related to audio monitoring.

Menu item Settings Description

Monitor CH When Monitor Output CH Pair is 

set to CH-1/CH-2

CH-1/CH-2, CH-1, CH-2

When Monitor Output CH Pair is 

set to CH-3/CH-4

CH-3/CH-4, CH-3, CH-4

Selects the audio channel that is output to the 

headphones and speaker.

CH-1/CH-2 (CH-3/CH-4): Channel 1+2 (Channel 

3+4)

CH-1 (CH-3): Channel 1 (Channel 3) only

CH-2 (CH-4): Channel 2 (Channel 4) only

Monitor Level 0 to 99 Adjusts the monitor audio level.

Audio > Audio Configuration

Makes settings related to audio input/output.

Menu item Settings Description

Input Limiter Mode Off/–6dB/–9dB/–12dB/–15dB/ 

–17dB

Selects the limiter characteristic (saturation level) 

for large input signals when adjusting the audio 

input level manually. Select Off if not using the 

limiter.

AGC Level –6dB/–9dB/–12dB/–15dB/–17dB Selects the AGC characteristic (saturation level).

AGC Mono/Stereo Mono/Stereo Automatically adjusts the input level of analog 

audio signals recorded on channels 1 and 2, and 

selects whether to make the adjustments 

separately for each channel (Mono) or in stereo 

mode (Stereo).

Audio > Audio Configuration

Makes settings related to audio input/output.

Menu item Settings Description

MIC Input Mono/

Stereo

Mono/Stereo Selects whether the front microphone is 

monaural (Mono) or stereo (Stereo).

Phantom Power +48V On/Off Turns the function to supply a +48 V external 

source (phantom power) to the microphone on/

off.

Monitor Output CH 

Pair

CH-1/CH-2, CH-3/CH-4 Sets the audio output channels to either channels 

1 and 2 or channels 3 and 4.

Headphone Mono/ST Mono/Stereo Sets the headphones output to monaural (Mono) 

or stereo (Stereo).
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Technical Menu

Default values are shown underlined and in bold text.

Technical > Test Signals

Makes settings related to color bars.

Menu item Settings Description

Color Bars On/Off Turns color bars on/off.

Color Bars Type ARIB/SMPTE Selects the type of color bars.

1KHz Tone on Color 

Bars

On/Off Turns the function to output a 1 kHz test signal in 

color bars mode on/off.

Test Saw On/Off Turns the test signal on/off.

Technical > Switch & Rec Light

Makes settings related to the REC button.

Menu item Settings Description

Lock Operator Side without Rec Button/with Rec 

Button

Sets whether to lock the REC button operation 

when buttons are locked using the LOCK switch 

on the Operator side.

Lock Assistant Side without Rec Button/with Rec 

Button

Sets whether to lock the REC button operation 

when buttons are locked using the LOCK switch 

on the Assistant side.

Rec Light On/Off Turns the REC lamp on/off.

Rec Start/Stop Beep On/Off Turns the function to emit a beep sound when 

recording starts and stops on/off.

Technical > System Configuration

Makes settings related to control of the unit.

Menu item Settings Description

Fan Control Auto/Max/Off in Rec/Auto/ 

Off in Rec/Max

Selects the fan control mode.

Auto: Controls the fan automatically in response 

to the internal temperature.

Max: Fan rotates at maximum speed.

Off in Rec/Auto: The fan is silent when recording, 

and operates automatically in response to the 

internal temperature when not recording.

Off in Rec/Max: The fan is silent when recording, 

and rotates at maximum speed when not 

recording.

Lens Interface Type C/Off Sets the lens interface, before attaching a lens, 

according to the lens type to attach.

[Note]
If changing this setting while the lens is attached to the 

unit, turn the turn off and then on again.

Technical > System Configuration

Makes settings related to control of the unit.

Menu item Settings Description

SDI Rec Remote 

Trigger

Off/HD SDI Remote I/F/Parallel 

Rec

Selects the SDI remote mode control method.

Off: Disables remote control.

HD SDI Remote I/F: Uses HD SDI Remote control 

method.

Parallel Rec: Uses valid flag control method.

SD HDMI On/Off Turns the function to set the HDMI output signal 

to SD format on/off.

Shutter Mode Speed/Angle Selects the operating mode of the electronic 

shutter.

Technical > APR

Executes APR (Auto Pixel Restoration: auto adjustment of the image sensor).

Menu item Settings Description

APR Execute/Cancel Executes the automatic pixel noise reduction 

function (execute by selecting Execute).

Reset Execute/Cancel Deletes white flecks added by execution of the 

APR and automatic black balance adjustment 

functions (execute by selecting Execute).

Technical > Battery

Makes settings related to batteries.

Menu item Settings Description

Near End:Info Battery 5% to 100% (5% increments) Sets the threshold value at which the remaining 

battery capacity indicator starts flashing when 

using an InfoLithium battery.

End:Info Battery 0% to 5% Sets the threshold value for displaying the “Battery 

End” warning when using an InfoLithium battery.

Near End:Sony Battery 11.5V to 17V (0.1V increments) Sets the threshold value at which the remaining 

battery capacity indicator starts flashing when 

using a Sony non-InfoLithium battery.

End:Sony Battery 11.0V to 11.5V (0.1V increments) Sets the threshold value for displaying the “Battery 

End” warning when using a Sony non-InfoLithium 

battery.

Near End:Other Battery 11.5V to 17V (11.8V) (0.1V 

increments)

Sets the threshold value at which the remaining 

battery capacity indicator starts flashing warning 

when using a non-Sony battery.

End:Other Battery 11.0V to 14V (0.1V increments) Sets the threshold value for displaying the “Battery 

End” warning when using a non-Sony battery.

Detected Battery Sony Info Battery/Sony Battery/

Other Battery/DC IN (12V)/DC IN 

(24V)

Displays the result of automatic battery pack type 

detection.
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Technical > DC Voltage Alarm

Sets alarms relating to external DC supply voltage.

Menu item Settings Description

DC Low Voltage1 11.5V to 17V (0.1V increments) Sets the threshold value for displaying a low 

voltage warning when using an external power 

source connected to the DC IN connector.

DC Low Voltage2 11.0V to 14V (0.1V increments) Sets the threshold value for displaying an 

undervoltage warning when using an external 

power source connected to the DC IN connector.

DC(24V) Low Voltage1 22.5V to 34.0V (0.1V increments) Sets the threshold value for displaying a low 

voltage warning when using a 24 V external 

power source connected to the DC IN connector.

DC(24V) Low Voltage2 22.0V to 28.0V (0.1V increments) Sets the threshold value for displaying an 

undervoltage warning when using a 24 V external 

power source connected to the DC IN connector.

Technical > Control Display

Makes settings related to the displays.

Menu item Settings Description

Brightness level High/Mid/Low/Minimum Adjusts the brightness of the sub display and mini 

display.

Technical > Genlock

Makes settings related to genlock.

Menu item Settings Description

Input Source HD SDI/Analog Selects the genlock input signal.

HD SDI: Digital

Analog: Analog

Reference Lock Type Internal/External(HD)/

External(SD)

Displays the genlock status. Displays the signal 

type when genlocked.

Internal: Not genlocked.

External(HD): Genlocked by the HD signal.

External(SD): Genlocked by the SD signal.

Maintenance Menu

Default values are shown underlined and in bold text.

Maintenance > Clock Set

Makes settings related to the built-in clock.

Menu item Settings Description

Time Zone UTC + 14:00 to UTC Greenwich 

to UTC – 12:00 (30-minute 

increments)

Selects the difference in time from UTC 

(Greenwich Mean Time) in units of 30 increments.

Date Mode YYMMDD/MMDDYY/DDMMYY Selects the display format for dates.

YYMMDD: Year, month, day

MMDDYY: Month, day, year

DDMMYY: Day, month, year

Date Sets the current date (apply by pressing Set).

Time Sets the current time (apply by pressing Set).

Maintenance > Language

Selects the display language for menus and messages.

Menu item Settings Description

Select English/中文(简) Selects the display language for the full menu and 

messages.

Maintenance > Hours Meter

Displays the accumulated usage time.

Menu item Settings Description

Camera(System) Displays the accumulated time of use of the unit 

(cannot be reset).

R7 Recorder 

(System)

(Only when an AXS-R7 

is attached)

Displays the accumulated time of use of the AXS 

recorder connected to the unit (cannot be reset).

Camera(Resettable) Displays the accumulated time of use of the unit 

(can be reset).

R7 Recorder 

(Resettable)

(Only when an AXS-R7 

is attached)

Displays the accumulated time of use of the AXS 

recorder connected to the unit (can be reset).

Reset-Cam 

(Resettable)

Execute/Cancel Resets the Camera(Resettable) display to 0 

(execute by selecting Execute).

Reset-R7 

(Resettable)

(Only when an AXS-R7 

is attached)

Execute/Cancel Resets the R7 Recorder(Resettable) display for the 

AXS recorder connected to the unit to 0 (execute 

by selecting Execute).
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Maintenance > Reset to Default

Returns the unit to factory default state.

Menu item Settings Description

Reset Execute/Cancel Initializes all unit settings (execute by selecting 

Execute).

Maintenance > License Options

Installs software options.

Menu item Settings Description

Install: <target_

license>

Execute/Cancel Installs software options (execute by selecting 

Execute).

Anamorphic Permanent License Installed/ 

XX days Remaining (YY keys)/

Expired/Not Installed

Displays whether the Anamorphic option is 

enabled.

Permanent License Installed: Permanent license is 

installed

XX days Remaining (YY keys): Expiration of timed 

license

Expired: Timed license has expired

Not Installed: Not installed

Full Frame Permanent License Installed/ 

XX days Remaining (YY keys)/

Expired/Not Installed

Displays whether the Full Frame option is 

enabled.

Permanent License Installed: Permanent license is 

installed

XX days Remaining (YY keys): Expiration of timed 

license

Expired: Timed license has expired

Not Installed: Not installed

Unique Device ID Displays the ID used for issuing the software 

option license key.

Maintenance > Firmware

Displays the version of the unit and AXS recorder, and updates the unit.

Menu item Settings Description

Camera Displays the firmware version of the unit (Vx.xx).

AXS

(Only when an AXS-R7 

is attached)

Displays the firmware version of the AXS recorder 

connected to the unit (Vx.xx).

FW Update-camera Execute/Cancel Updates the unit (execute by selecting Execute).
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Clip Operations
Clip operations are performed using the clip list screen and the playback screen. You can play a clip by 

selecting the clip to play from the clip list screen displayed on the sub display.

When AXS Rec Format is not set to Rec Off in the Project category in the menu, AXS media becomes 

playable. Similarly, when SxS Rec Format is not set to Rec Off, SxS media becomes playable.

Clip List Screen

Press the CLIPS button (page 8) on the Assistant side to display the clip list screen for playable media 

on the sub display.

XAVC QFHD C480

Dur 00:00:01:56

TCR 00:00:00:00

PlaySxS / AXS

SxS A OK

OKSub

OKSub

OKSub

OKSub

OKSub

Sub

23.98fps 4K 4:3 2x

2018/1/1 11:30

002/010

A001C001_180101CQ

A001C002_180101G7

A001C003_180101HR

A001C004_180101WK

A001C005_180101S8

A001C006_180101GF

1 2

5

3

4

12
11
10

9
8

7
6

1. Media select button

Displays “SxS/AXS” if both SxS and AXS media 

are playable. Press ITEM key 1 to switch the 

playback media.

2. Cursor up button

Press ITEM key 2 to select the clip to play from 

the clip list.

3. Playback start button

Press ITEM key 3 to display the playback screen 

(page 13) and start playback.

4. Clip list

Displays a list of clips on the active playback 

media. It also displays the clips status using 

icons.

Icon Meaning

Clip with a created sub clip

Locked (write protection) clip

5. Cursor down button

Press ITEM key 5 to select the clip to play from 

the clip list.

6. Clip position in playback media

Displays the number of the clip indicated by 

the cursor and total number of clips.

7. Creation date and time

Displays the creation date and time of the clip 

indicated by the cursor.

8. Format (codec)

Displays the recording format (codec) of the 

clip indicated by the cursor.

9. Project frame rate/picture size indicator

Displays the project frame rate and picture size 

of the clip indicated by the cursor.

10. Duration (Dur)

Displays the duration of the clip indicated by 

the cursor.

11. Timecode (TCR)

Displays the timecode of the first frame of the 

clip indicated by the cursor.

12. Active playback media

Displays the active playback media of the 

displayed list.
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Playback Screen

The playback screen is displayed when you select a clip to play on the clip list screen and press the MENU 

dial or Play button (ITEM key 3).

Function display area

F R ev Play/ Pause F Fwd

 FPS 60DC IN 15.0V

23.98fps

1 2

Dur 00: 00: 00: 00

A 002/010SXS

x24

X AVC QFHD C480

Prev Stop/Clips Next

A 001C 002_160328WW OKS ub

3.8K 16:9

1 2 3

4 5 6

1. F Rev button

Play back at high speed in the reverse 

direction.

2. Play/Pause button

Play a clip or pause playback.

3. F Fwd button

Play back at high speed in the forward 

direction.

4. Prev button

Skip to the start of the previous clip.

5. Stop/Clips button

Stop playback and return to the clip list screen.

6. Next button

Skip to the start of the next clip.

Status display area

DC IN 15.0V

3.8K 16:923.98fps

1 2

Dur 00:00:00:00

A 002/010SXS

x24

XAVC QFHD C480

A001C002_160328WW Sub

1 2 3

7 6

49

5

8

1. Time data display

Displays the timecode of the playback 

position.

2. Clip number

Displays the Current playback clip number/

Total number of playable clips.

3. Frame rate/imager mode indicator

Displays the project frame rate and picture 

size.

4. Audio level meters

Displays the playback audio level.

5. Playback clip format (codec) indicator

Displays the format (codec) of the playback 

clip.

6. Icon display

Displays the clip status using icons.

Icon Meaning

Clip with a created sub clip

Locked (write protection) clip

7. Clip name indicator

Displays the name of the clip.

8. Media indicator

Displays the media being played.

9. Playback status indicator

Displays the playback status.
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Playback
You can play recorded clips while the unit is in 

standby mode.

[Note]
The playback controls appear on ITEM keys 1 to 6 

(page 7). Press an ITEM key to select the corresponding 

item.

1 Insert the SxS memory card to play .

2 Press the CLIPS button (page 8) on the 

Assistant side.

The clip list on the active playback media 

appears on the sub display.

3 Press the  button (ITEM key 2),  button 

(ITEM key 5), or MENU dial to select a clip to 

play.

4 Press the MENU dial or the Play button (ITEM 

key 3).

The playback image appears on the viewfinder 

screen.

12:34:56:00 A001C001 Play XCON ST AAXS 1 2

BAT min120 

Playback operations

Playback operation is performed using the buttons 

on the sub display (page 53).

Play/Pause button: Pause playback. To resume 

playback, press this button again.

F Fwd button/F Rev button: Fast forward/reverse. 

To return to normal playback, press the Play/

Pause button.

Stop/Clips button: Stop playback and return to the 

clip list screen.

Monitoring audio

In normal playback mode, you can monitor the 

recorded audio through the built-in speaker 

(page 6) or connected headphones.

When headphones are connected to the 

headphones connector (page 6), the built-in 

speaker is turned off.

You can select the channel to monitor and adjust 

the volume using Audio category > Monitor CH 

and Monitor Level (page 38) in the menu.

Cueing up

To play from the start of a clip, press the Prev 

button on the sub display (page 27).

You can skip clips and cue-up another clip 

by pressing the Prev button or Next button 

repeatedly.

Switching the SxS memory cards

When two SxS memory cards are loaded, press 

the SLOT SELECT button (page 7) to switch 

memory cards.

[Note]
You cannot switch SxS memory cards during playback. 

Continuous playback of cards in slots A and B is not possible.

Switching to an AXS memory card

You can quickly play video recorded on an AXS 

memory card in the AXS-R7.

To switch to an AXS memory card, press ITEM key 

1 (page 27) on the sub display.

The playback signal is output from the output 

connector of the unit.
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Operations on the Home Screen of the Mini Display
You can check the status of the unit and set basic 

settings for the unit on the Home screen of the 

mini display.

FPS

ND

WB

El

Fixed 24

Clear
500

5600+00

180.0
1
2
3
4
5

1. FPS

Displays the video frame rate.

2. Shutter

Displays and sets the shutter speed/shutter 

angle of the electronic shutter.

3. ND Filter

Displays and sets the density of the ND filter.

4. Exposure Index

Displays and sets the exposure index (EI).

5. WB (White Balance)

Displays and sets the white balance.

Controls

HOME button (page 6)
Press to return to the Home screen. Unconfirmed 

changes are canceled.

ITEM key 1 ( ) (page 6)
Press to select items on the Home screen.

ITEM key 2 ( ) (page 6)
Press to apply the selected item.

ITEM key 3 ( ) (page 6)
Press to select items on the Home screen.

Basic Operation

1 Press ITEM key 1, 2, or 3.

The cursor appears.

2 Select the item to set using the  button 

(ITEM key 1) or  button (ITEM key 3).

FPS Fixed

ND

WB

El

24

Clear
500

5600+00

180.0

3 Press the  button (ITEM key 2).

The setting value selection screen appears for 

the selected item.

El
640
500
400
320

 [Note]

The  mark indicates the current setting.

4 Move the cursor to the item or setting value 

using the  button (ITEM key 1) or  button 

(ITEM key 3).

5 Press the  button (ITEM key 2) to apply the 

setting.

6 Press the HOME button to hide the cursor.
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Home Screen Items on the Mini Display

The names of items and corresponding setting values are given below.

Default values are shown underlined and in bold text.

Item Description

FPS Displays the video frame rate. The setting is determined by the Project category > 

Project Frame Rate setting (page 36) in the menu.

Project Frame Rate Display

23.98 Fixed 24

24 Fixed 24

25 Fixed 25

29.97 Fixed 30

50 Fixed 50

59.94 Fixed 60

Exposure Index Sets the EI value. The following settings are available.

125EI/160EI/200EI/250EI/320EI/400EI/500EI/640EI/800EI/1000EI/ 

1250EI/1600EI/2000EI

Shutter Sets the electronic shutter angle/shutter speed.

Select from preset values registered as shutter steps.

[Note]
Not available when the electronic shutter operation is set to Continuous.

Displays the following selection options depending on the Technical > System 

Configuration > Shutter Mode (page 49) setting in the full menu.

Angle (Δ): Shutter angle indicator

360.0/180.0/172.8/144.0/90.0/45.0/22.5/11.2 1)

Speed (SS): Shutter speed indicator

1/24, 1/25, 1/30, 1/50, 1/60, 1/100, 1/120, 1/250, 1/500, 1/1000, 1/2000 1)

ND Filter Sets the density of the ND filter. The following settings are available.

Clear/0.3/0.6/0.9/1.2/1.5/1.8/2.1/2.4

WB (White Balance) Sets the color temperature of the white balance.

Select from preset values registered as WB steps.

3200K+00/4300K+00/5500K+00 1)

1) The selection options can be changed using Step Edit on the Home screen of the sub display.
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Basic Operations
Basic recording can be performed with the 

following procedures.

1 Make sure that the necessary devices are 

attached to the unit and power is supplied to 

them.

2 Set the power switch (page 6) to the ON 

position.

The recording screen is displayed on the 

viewfinder screen.

3 Load the memory card(s).

If you load two SxS memory cards, recording is 

continued by automatically switching to the 

second card when the first card becomes full.

4 Press the REC button (pages 6, 8).

The REC lamp lights and recording begins.

 [Note]
If the unit cannot start recording immediately after the 

pressing the REC button, the REC lamp flashes. The REC 

lamp lights when recording starts.

5 To stop recording, press the REC button again.

Recording stops and the unit enters STBY 

(recording standby) mode.

When you stop recording, the video, audio, 

and subsidiary data from the start to the end 

of the recording are recorded as a single clip.

Clip names

Clip names are recorded using the “Cam ID + 

Reel#” format. The clip name is created according 

to the following rules.

ˎˎ When there is already a clip that is stored using 

the “Cam ID + Reel#” name format on the 

inserted SxS memory card or AXS memory card, 

the new file inherits from the last file.  

Example: If “B002C003_XXXXXXXX” exists on the 

AXS memory card, the next created clip will be 

named “B002C004_XXXXXXXX.”

ˎˎ If the inserted AXS memory card has no files, “1” 

is added to the Reel Number of the clip that was 

recorded last.  

Example: If you record on empty card 2 after 

recording up to “D001CXXX_XXXXXXXX” on 

card 1, the next created clip will be named 

“D002C001_XXXXXXXX.” The clip name flashes 

until recording starts.

ˎˎ If you set Camera ID and Reel Number using TC/

Media category > Clip Naming in the menu, that 

information is applied.  

Example: If you change Camera ID to “F” and 

Reel Number to “001” in the menu for the 

AXS memory card that has recorded up to 

“E003CXXX_XXXXXXXX,” the next clip will 

be named “F001CXXX_XXXXXXXX.” When 

you change Camera ID only, Reel Number is 

changed to “001.”

Maximum duration of a clip

The maximum single clip length that you can 

record to an SxS memory card is 6 hours.

Recording stops if the recording time exceeds the 

maximum clip duration.
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Useful Functions

Simultaneous Recording (Simul Rec)

You can simultaneously record two sizes of 

pictures on an SxS memory card in one slot. You 

can also simultaneously record an HD signal on an 

SxS memory card in the unit while recording video 

and audio in RAW format on the AXS-R7.

You can perform simultaneous recording using 

Project category > AXS Rec Format and SxS Rec 

Format or SxS Rec Format and Sub Rec Format 

in the menu as described in “Recording Format 

Settings” (page 39).

[Note]
In simultaneous recording mode, the unit cannot switch to 

the second card automatically even if a card becomes full.

In 1-slot simultaneous recording, the XAVC 4K 

Class480/XAVC 4K Class300/XAVC QFHD Class480/

XAVC QFHD Class300 clip is recorded in the 

XDROOT/Clip directory on the SxS memory card, 

but the MPEG2 1920×1080 clip is recorded in the 

XDROOT/Sub directory on the SxS memory card. 

The suffix “S02” is appended to the end of the clip 

name.

Recording Review (Rec Review)

You can review the last recorded clip on the 

screen by assigning the Rec Review function to 

one of assignable buttons 1 to 4 (page 32).

When you stop recording and press the button 

assigned with Rec Review, the clip is played at 

normal speed starting from the first frame.

The clip is played to the end, then Rec Review 

ends and the unit returns to STBY (recording 

standby) mode.

If the HOME button is pressed on the Operator 

side or Assistant side during playback, playback 

stops and the unit switches to shooting mode.

Focus Magnifier Function

By pressing the FOCUS MAG button of the 

viewfinder (DVF-EL200, DVF-L700) attached to 

the unit, you can expand the center part of the 

viewfinder, making it is easier to adjust the focus. 

After adjusting the focus, press the button again to 

return to the normal (recording) screen.

The magnified display does not affect the recorded 

image or output signal.

Viewfinder Double Speed Scan 

Function

If the project frame rate is 23.98P, 24P, 25P, or 

29.97P, the image may become blurred and hard 

to see due to low frame frequency when you 

shoot while swaying the unit to the right and the 

left.

In this case, you can decrease image blur and 

make it easier to see by activating the viewfinder 

double speed scan function.

To activate the function, set Monitoring category > 

Moni. Details > VF Function > Double Speed Scan 

(page 47) in the menu to On.

[Note]
When this function is activated, the shutter angle of the 

electronic shutter function is limited to 180 degrees or lower.



00059 5. Connecting External Devices

Connecting External Monitors and Recording Devices
To display the recording/playback image on an 

external monitor, select the output signal and 

use an appropriate cable for the monitor to be 

connected.

The output signal from the unit can be recorded 

by connecting a recording device, such as a VTR.

The same status information and menus can be 

displayed on the external monitor as those on 

the viewfinder screen. Set the content to display, 

according to the output signal for the monitor, 

using the Monitoring menu (page 45).

SDI OUT Connector (BNC Type)

Set the output format using the Monitoring menu 

(page 45).

Use a commercially available 75-ohm coaxial cable 

for connection.

[Note]
Check that the ground connection between the unit and 

external device is securely grounded before turning the 

power on. (We recommend turning on the unit and external 

device after connecting a 75-ohm coaxial cable.)

When connecting an external device to the unit while the 

unit is turned on, connect to the unit after connecting a 75-

ohm coaxial cable to the external device.

To start synchronized recording on an external 

device

With SDI signal output selected, synchronized 

recording is possible by feeding a REC 

trigger signal to an external recording device 

connected to the SDI OUT connector. Enable 

synchronized recording by setting Technical > 

System Configuration > SDI Rec Remote Trigger 

(page 49) in the menu to HD SDI Remote I/F or 

Parallel Rec.

[Note]
When a connected external device does not support a REC 

trigger signal, the device cannot be operated.

MONITOR OUT Connector (BNC Type)

Outputs an HD SDI signal.

Set the output format using the Monitoring menu 

(page 45).

Use a commercially available 75-ohm coaxial cable 

for connection.

HDMI OUT Connector (Type A 

Connector)

Set the output format using the Monitoring menu 

(page 45).

Use a commercially available HDMI cable for 

connection.

If the output format has the same resolution as the 

MONITOR OUT connector signal, the same video 

signal is output.

12V OUT Connector (DC OUT 12V, 

Hirose 4-pin)

Supplies 12 V DC power to an accessory when the 

power switch is set to ON. You can output a REC 

Tally signal and input a REC Trigger signal through 

the 12V OUT connector.

No. Signal I/O Specification

1 UNREG GND – GND for UNREG

2 REC TALLY OUT Open-collector 

output

(Max. 50 mA)

Low: REC

3 REC TRIGGER IN Open or +5 V DC: 

Normal

GND: Active (REC)

4 UNREG +12 V 

OUT

OUT +11 V to 17 V DC 

output

11 V to 17 V input

Output voltage: 

Same as the input 

voltage

Maximum output 

current: 1.0 A

22 V to 32 V input

Output voltage :  

15 V

Maximum output 

current: 0.8 A

24V OUT Connector (DC OUT 24 V, 

Fischer 3-pin)

Supplies 24 V DC power to an accessory when the 

power switch is set to ON. You can output a REC 

Tally signal and input a REC Trigger signal through 

the 24V OUT connector.

No. Signal Specification

1 GND

2 24V-AUX 11 V to 17 V input

Output voltage : 24 V

Maximum output current: 

1.0 A

22 V to 32 V input

Output voltage: Same as 

the input voltage

Maximum output current: 

2.0 A

3 R/S
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AUX Connector (LEMO 5-pin)

Outputs the timecode signal.

No. Signal

1 Factory Use

2 NC

3 –

4 TC OUT

5 GND
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When shooting with multiple units, synchronized 

recording can be performed using a specific 

reference signal to synchronize the timecode 

among all the units.

Synchronizing the Phase of the Video 

Signal (Genlock)

Genlock operation is enabled by supplying one of 

the following reference signals to the GENLOCK IN 

connector (page 9) of the unit.

ˎˎ HDSDI 1.5G digital I (Interlaced or PsF)

ˎˎ HD Y analog

ˎˎ SD VBS analog

Set the genlock input signal using Technical > 

Genlock > Input Source (page 50) in the full 

menu.

Valid input reference signals vary depending on 

the project frame rate setting.

Project frame 

rate

Valid reference signal

23.98P 1920×1080 47.95i (23.98PsF)

24P 1920×1080 48i (24PsF)

25P 1920×1080 50i

720×576 50i

29.97P 1920×1080 59.94i

720×486 59.94i

50i 1920×1080 50i

720×576 50i

50P 1920×1080 50i

720×576 50i

59.94i 1920×1080 59.94i

720×486 59.94i

59.94P 1920×1080 59.94i

720×486 59.94i

You can check the genlock status using Technical 

> Genlock > Reference Lock Type (page 50) in 

the menu.

[Notes]

ˎˎ If the reference signal is unstable, genlock is not possible.

ˎˎ The subcarrier is not synchronized.

Synchronizing the Timecode with 

Another Device

Set the unit that supplies the timecode to a mode 

in which the timecode output keeps advancing 

(Free Run mode).

1 Set TC/Media > Timecode > Mode (page 44) 

in the menu to Preset F-Run (Ext-Lk).

2 Supply an HD or SD reference video signal to 

the GENLOCK IN connector (page 9) and a 

reference timecode synchronized with that 

signal to the TC IN (page 9) connector.

The built-in timecode generator of your unit locks 

to the reference timecode, and the message “Ext-

Lk” is displayed on the screen.

Once about ten seconds have elapsed after 

the timecode locks, the external lock state is 

maintained even if the external timecode source is 

disconnected.

[Notes]

ˎˎ Check that the reference timecode and the reference 

video signal are in a phase relationship that complies with 

the SMPTE timecode standards.

ˎˎ When you finish the above procedure, the timecode is 

immediately synchronized with the external timecode, 

and the time data indication will show the value of the 

external timecode. However, wait for a few seconds until 

the timecode generator stabilizes before recording.

ˎˎ If the frequency of the reference video signal and the 

frame frequency are not the same, lock cannot be 

acquired, and the unit will not operate properly. If this 

occurs, the timecode will not acquire successful lock with 

the external timecode.

ˎˎ When the connection is removed, the timecode advance 

may shift one frame per hour with respect to the 

reference timecode.

To release external lock

Change the TC/Media > Timecode > Mode 

(page 44) setting in the menu.

External Synchronization
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Usage Precautions
Read this section in conjunction with the 

information provided in the supplied “Before Using 

this Unit” document.

Use and Storage

Do not subject the unit to severe shock

The internal mechanism may be damaged or the 

body warped.

Do not cover the unit while operating

Putting a cloth, for example, over the unit can 

cause excessive internal heat build-up.

After use

Always set the power switch to OFF.

Before storing the unit for a long period

Remove the battery pack.

Do not leave the unit with the lens facing the sun

Direct sunlight can enter through the lens, be 

focused in the unit, and cause fire.

Shipping

ˎˎ Remove the memory cards before transporting 

the unit.

ˎˎ If sending the unit by truck, ship, air or other 

transportation service, pack it in the shipping 

carton of the unit.

Care of the Unit

If the body of the unit is dirty, clean it with a soft, 

dry cloth. In extreme cases, use a cloth moistened 

in a little neutral detergent, then wipe dry.

Do not use organic solvents, such as alcohol or 

thinners, as these may cause discoloration or other 

damage to the finish of the unit.

Refrain from cleaning with high air pressure 

equipment, such as an air duster, as these may 

damage optical components.

In the event of operating problems

If you should experience problems with the unit, 

contact your Sony dealer.

Periodic Replacement of Fan and 

Battery

The fan and battery are consumable parts that will 

need periodic replacement.

When operating at room temperature, a 

normal replacement cycle will be about 5 years. 

However, this replacement cycle represents only 

a general guideline and does not imply that the 

life expectancy of these parts is guaranteed. For 

details on parts replacement, contact your dealer.

Life Expectancy of the Electrolytic 

Capacitor

The life expectancy of the electrolytic capacitor 

is about 5 years under normal operating 

temperatures and normal usage (8 hours per day; 

25 days per month).

If usage exceeds the above normal usage 

frequency, the life expectancy may be reduced 

correspondingly.

Note about the Battery Terminal

The battery terminal of this unit (the connector for 

battery packs and AC adaptors) is a consumable 

part.

Power may not be supplied to the unit properly 

if the pins of the battery terminal are bent or 

deformed by shock or vibrations, or if they become 

corroded due to prolonged outdoor use.

Periodic inspections are recommended to keep 

the unit working properly and to prolong its 

usable lifetime.

Contact a Sony service or sales representative for 

more information about inspections.

Use and Storage Locations

Store in a level, ventilated place.

Avoid using or storing the unit in the following 

places.

ˎˎ In excessive heat or cold (operating temperature 

range: 0 °C to 40 °C (32 °F to 104 °F))  

Remember that in summer in warm climates 

the temperature inside a car with the windows 

closed can easily exceed 50 °C (122 °F).

ˎˎ In damp or dusty locations

ˎˎ Locations where the unit may be exposed to 

rain

ˎˎ Locations subject to violent vibration

ˎˎ Near strong magnetic fields

ˎˎ Close to radio or TV transmitters producing 

strong electromagnetic fields.

ˎˎ In direct sunlight or close to heaters for 

extended periods

To prevent electromagnetic interference from 

portable communications devices

The use of portable telephones and other 

communications devices near this unit can result 

in malfunctions and interference with audio and 

video signals.

It is recommended that the portable 

communications devices near this unit be 

powered off.

Note on laser beams

Laser beams may damage the CMOS image 

sensor. If you shoot a scene that includes a laser 

beam, be careful not to let the laser beam be 

directed into the lens of the unit. Specifically, high-

power laser beams from medical devices or other 

devices may cause damage due to reflected light 

and scattered light.

About the Screens

ˎˎ Do not leave the screens facing direct sunlight, 

as this may damage the screens.

ˎˎ Do not press/swipe the screens forcefully, or 

leave objects on the screens, as it may cause a 

malfunction, such as picture irregularity, etc.

ˎˎ The screens may become warm in use. This is 

not a malfunction.
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LCD and OLED Panels

The LCD panel fitted to this unit is manufactured 

with high precision technology, giving a 

functioning pixel ratio of at least 99.99%. Thus a 

very small proportion of pixels may be “stuck”, 

either always off (black), always on (red, green, or 

blue), or flashing. In addition, over a long period 

of use, because of the physical characteristics of 

the liquid crystal display, such “stuck” pixels may 

appear spontaneously.

These problems are not a malfunction.

Note that any such problems have no effect on 

recorded data.

The OLED (organic light emitting diode) panel 

of this unit may also exhibit “stuck” pixels and/

or bright spots. These problems are not a 

malfunction.

On Condensation

If the unit is suddenly taken from a cold to a warm 

location, or if ambient temperature suddenly 

rises, moisture may form on the outer surface of 

the unit and/or inside of the unit. This is known 

as condensation. If condensation occurs, turn off 

the unit and wait until the condensation clears 

before operating the unit. Operating the unit while 

condensation is present may damage the unit.

Phenomena Specific to CMOS Image 

Sensors

The following phenomena that may appear in 

images are specific to CMOS (Complementary 

Metal Oxide Semiconductor) image sensors. They 

do not indicate malfunctions.

White flecks

Although the CMOS image sensors are produced 

with high-precision technologies, fine white 

flecks may be generated on the screen in rare 

cases, caused by cosmic rays, etc. This is related 

to the principle of image sensors and is not a 

malfunction.

The white flecks especially tend to be seen in the 

following cases.

ˎˎ When operating at high environmental 

temperatures

Aliasing

When fine patterns, stripes, or lines are shot, they 

may appear jagged or flicker.

Focal plane

Owing to the characteristics of the pickup 

elements (CMOS sensors) for reading video signals, 

subjects that quickly move across the screen may 

appear slightly skewed.

Flashbanding

The luminance at the top and bottom of the 

screen may change when shooting a flashlight 

beam or a light source that quickly flashes.

Flicker

If recording is made under lighting produced 

by discharge tubes, such as fluorescent, sodium, 

or mercury-vapor lamps, the screen may flicker, 

colors may vary, or horizontal stripes may appear 

distorted.

Notes on the Display

ˎˎ Pictures on the viewfinder screen may be 

distorted by the following operations.

 – Changing the video format

ˎˎ When you change the line of sight in the 

viewfinder, you may see primary colors red, 

green, and blue, but this is not a defect of the 

unit. These primary colors are not recorded on 

any recording media.

Fragmentation

If pictures cannot be recorded/reproduced 

properly, try formatting the recording medium. 

While repeating picture recording/playback with 

a certain recording media for an extended period, 

files in the media may be fragmented, disabling 

proper recording/storage. In such a case, make 

a backup of clips in the media then perform 

formatting of the media using TC/Media > Format 

Media (page 44) in the menu.

Output Voltages of the Unit

The total output power that can be supplied to 

peripheral devices from the unit varies depending 

on the input voltage to the unit and the state of 

the connected accessories. The maximum output 

capacity ratings of the following connectors 

that can supply power may not be achieved 

depending on the conditions.

LENS connector: 1 A max.

12V OUT connector (4-pin):

0.8 A max. (Input voltage: 22 V to 32 V)

1 A max. (Input voltage: 11 V to 17 V)

24V OUT connector (3-pin):

2 A max. (Input voltage: 22 V to 32 V)

1 A max. (Input voltage: 11 V to 17 V)

When an AXS-R7 and DVF-EL200 are attached and 

the input voltage to the unit is 14 V or lower, the 

power rating available for peripheral devices is 

limited.

Total power rating of peripheral devices: Y [W]

Voltage of power supply to the unit: X [V]

Power consumption of the unit: Approx. 60 W

Power consumption of the AXS-R7:  

Approx. 24 W

Power consumption of the DVF-EL200:  

Approx. 2.5 W

Y [W] = X [V] × 9.0 [A] 1) – (60 + 24 + 2.5) [W]

When supplying power from the unit to 

peripheral devices, make sure that the total power 

requirement does not exceed the total power 

rating given by the equation above.

(Note that the equation does not apply if the 

calculated result exceeds the sum of the maximum 

allowable output power of each power output 

connector.)
1) 6.0 [A] when using the AC-DN10.
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SDI OUT Connector Output Formats

The serial digital signal from an SDI OUT connector is output according to the Project category and Monitoring category settings in the menu.

For details about Project category settings combinations, see “Recording Format Settings” (page 39).

Default values are shown underlined and in bold text.

Project Monitoring > Output Format Output format

Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4

59.94/50 4K 17:9 XAVC-I 4K Class300/

Rec Off

4096×2160P 2SI 4096×2160P 2SI 4096×2160P YPbPr 3G Level B-DL

4096×2160P Square 4096×2160P Square 4096×2160P YPbPr 3G Level B-DL

2048×1080P 1920×1080i
2048×1080P YPbPr 3G 

Level B-DL

2048×1080P YPbPr 3G 

Level B-DL
1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G

1920×1080P 1920×1080i
1920×1080P YPbPr 3G 

Level B-DL

1920×1080P YPbPr 3G 

Level B-DL
1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G

1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G

3.8K 16:9 XAVC-I QFHD 

Class300/Rec Off

3840×2160P 2SI 3840×2160P 2SI 3840×2160P YPbPr 3G Level B-DL

3840×2160P Square 3840×2160P Square 3840×2160P YPbPr 3G Level B-DL

1920×1080P 1920×1080i
1920×1080P YPbPr 3G 

Level B-DL

1920×1080P YPbPr 3G 

Level B-DL
1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G

1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G

4K 17:9/ 

3.8K 16:9

MPEG 1920×1080i
1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G 1920×1080i YPbPr 1.5G

29.97/25 4K 17:9 XAVC-I 4K Class480/

XAVC-I 4K Class300/

Rec Off

4096×2160P 2SI – 4096×2160P YPbPr 3G Level B-DS No output No output

4096×2160P Square 4096×2160P Square 4096×2160P YPbPr 1.5G

2048×1080PsF 1920×1080PsF
2048×1080PsF 

YPbPr 1.5G

2048×1080PsF 

YPbPr 1.5G

1920×1080PsF 

YPbPr 1.5G

1920×1080PsF 

YPbPr 1.5G

1920×1080PsF 1920×1080PsF
1920×1080PsF 

YPbPr 1.5G

1920×1080PsF 

YPbPr 1.5G

1920×1080PsF 

YPbPr 1.5G

1920×1080PsF 

YPbPr 1.5G

3.8K 16:9 XAVC-I QFHD Class480/

XAVC-I QFHD 

Class300/Rec Off

3840×2160P 2SI – 3840×2160P YPbPr 3G Level B-DS No output No output

3840×2160P Square 3840×2160P Square 3840×2160P YPbPr 1.5G

1920×1080PsF 1920×1080PsF
1920×1080PsF 

YPbPr 1.5G

1920×1080PsF 

YPbPr 1.5G

1920×1080PsF 

YPbPr 1.5G

1920×1080PsF 

YPbPr 1.5G

4K 17:9/ 

3.8K 16:9

MPEG 1920×1080P
1920×1080PsF 1920×1080PsF

1920×1080PsF 

YPbPr 1.5G

1920×1080PsF 

YPbPr 1.5G

1920×1080PsF 

YPbPr 1.5G

1920×1080PsF 

YPbPr 1.5G

24 6K 3:2/4K 4:3/ 

4K 17:9

XAVC-I 4K Class480/

XAVC-I 4K Class300/

Rec Off

4096×2160P 2SI – 4096×2160P YPbPr 3G Level B-DS No output No output

4096×2160P Square 4096×2160P Square 4096×2160P YPbPr 1.5G

2048×1080P 1920×1080P
2048×1080PsF 

YPbPr 1.5G

2048×1080PsF 

YPbPr 1.5G

1920×1080P 

YPbPr 1.5G

1920×1080P 

YPbPr 1.5G

1920×1080P 1920×1080P
1920×1080PsF 

YPbPr 1.5G

1920×1080PsF 

YPbPr 1.5G

1920×1080P 

YPbPr 1.5G

1920×1080P 

YPbPr 1.5G

Recording Formats and Output Signals
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Project Monitoring > Output Format Output format

Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4

23.98 6K 3:2/ 

4K 4:3/ 

4K 17:9

XAVC-I 4K Class480/

XAVC-I 4K Class300/

Rec Off

4096×2160P 2SI – 4096×2160P YPbPr 3G Level B-DS No output No output

4096×2160P Square 4096×2160P Square 4096×2160P YPbPr 1.5G

2048×1080P –
2048×1080PsF 

YPbPr 1.5G

2048×1080PsF 

YPbPr 1.5G

1920×1080P 

YPbPr 1.5G

1920×1080P 

YPbPr 1.5G

1920×1080P 1920×1080P
1920×1080PsF 

YPbPr 1.5G

1920×1080PsF 

YPbPr 1.5G

1920×1080P 

YPbPr 1.5G

1920×1080P 

YPbPr 1.5G

3.8K 16:9 XAVC-I QFHD Class480/

XAVC-I QFHD 

Class300/ 

Rec Off

3840×2160P 2SI – 3840×2160P YPbPr 3G Level B-DS No output No output

3840×2160P Square 3840×2160P Square 4096×2160P YPbPr 1.5G

1920×1080P 1920×1080P
1920×1080PsF 

YPbPr 1.5G

1920×1080PsF 

YPbPr 1.5G

1920×1080P 

YPbPr 1.5G

1920×1080P 

YPbPr 1.5G

4K 4:3/ 

4K 17:9/ 

3.8K 16:9

MPEG 1920×1080P

1920×1080P 1920×1080P
1920×1080PsF 

YPbPr 1.5G

1920×1080PsF 

YPbPr 1.5G

1920×1080P 

YPbPr 1.5G

1920×1080P 

YPbPr 1.5G
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MONITOR OUT Connector/HDMI OUT Connector Output Formats

The digital signal from the MONITOR OUT and HDMI OUT connectors is output according to the Project category and Monitoring category settings in the menu.

For details about Project category settings combinations, see “Recording Format Settings” (page 39).

Default values are shown underlined and in bold text.

Project Monitoring > Output Format Output format

Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI

59.94/50 4K 17:9 XAVC-I 4K Class300/ 

Rec Off
4096×2160P 2SI 4096×2160P 2SI 1920×1080i

4096×2160P
1920×1080i YPbPr 1.5G

4096×2160P

1920×1080i 1920×1080i

4096×2160P Square 4096×2160P Square 1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i 

2048×1080P 1920×1080i 1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i

1920×1080P 1920×1080i 1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i

1920×1080i 1920×1080i 1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i

3.8K 16:9 XAVC-I QFHD Class300/

Rec Off
3840×2160P 2SI 3840×2160P 2SI 1920×1080i

3840×2160P
1920×1080i YPbPr 1.5G

3840×2160P

1920×1080i 1920×1080i

3840×2160P Square 3840×2160P Square 1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i

1920×1080P 1920×1080i 1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i

1920×1080i 1920×1080i 1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i

4K 17:9/ 

3.8K 16:9

MPEG 1920×1080i

1920×1080i 1920×1080i

1920×1080i 1920×1080i 1920×1080i YPbPr 1.5G 1920×1080i

–
720×480P 1) 2) No output 720×480P

720×576P 1) 3) No output 720×576P

29.97/25 4K 4:3/4K 17:9 XAVC-I 4K Class480/

XAVC-I 4K Class300/ 

Rec Off

4096×2160P 2SI – 1920×1080PsF
4096×2160P

1920×1080PsF YPbPr 1.5G
4096×2160P

1920×1080PsF 1920×1080PsF

4096×2160P Square 4096×2160P Square 1920×1080PsF 1920×1080PsF 1920×1080PsF YPbPr 1.5G 1920×1080PsF

2048×1080PsF 1920×1080PsF 1920×1080PsF 1920×1080PsF 1920×1080PsF YPbPr 1.5G 1920×1080PsF

1920×1080PsF 1920×1080PsF 1920×1080PsF 1920×1080PsF 1920×1080PsF YPbPr 1.5G 1920×1080PsF

3.8K 16:9 XAVC-I QFHD Class480/

XAVC-I QFHD Class300/

Rec Off

3840×2160P 2SI – 1920×1080PsF
3840×2160P

1920×1080PsF YPbPr 1.5G
3840×2160P

1920×1080PsF 1920×1080PsF

3840×2160P Square 3840×2160P Square 1920×1080PsF 1920×1080PsF 1920×1080PsF YPbPr 1.5G 1920×1080PsF

1920×1080PsF 1920×1080PsF 1920×1080PsF 1920×1080PsF 1920×1080PsF YPbPr 1.5G 1920×1080PsF

4K 17:9/ 

3.8K 16:9

MPEG 1920×1080P
1920×1080PsF 1920×1080PsF 1920×1080PsF 1920×1080PsF 1920×1080PsF YPbPr 1.5G 1920×1080PsF

24 6K 3:2/ 

4K 4:3/ 

4K 17:9

XAVC-I 4K Class480/

XAVC-I 4K Class300/ 

Rec Off

4096×2160P 2SI – 1920×1080P
4096×2160P

1920×1080P YPbPr 1.5G
4096×2160P

1920×1080P 1920×1080P

4096×2160P Square 4096×2160P Square 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

2048×1080P 1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

1920×1080P 1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P
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Project Monitoring > Output Format Output format

Project Frame Rate Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI

23.98 6K 3:2/ 

4K 4:3/ 

4K 17:9

XAVC-I 4K Class480/

XAVC-I 4K Class300/ 

Rec Off

4096×2160P 2SI – 1920×1080P
4096×2160P

1920×1080P YPbPr 1.5G
4096×2160P

1920×1080P 1920×1080P

4096×2160P Square 4096×2160P Square 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

2048×1080P 1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

1920×1080P 1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

3.8K 16:9 XAVC-I QFHD Class480/

XAVC-I QFHD Class300/ 

Rec Off

3840×2160P 2SI – 1920×1080P
3840×2160P

1920×1080P YPbPr 1.5G
3840×2160P

1920×1080P 1920×1080P

3840×2160P Square 3840×2160P Square 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

1920×1080P 1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

4K 4:3/ 

4K 17:9/ 

3.8K 16:9

MPEG 1920×1080P

1920×1080P 1920×1080P 1920×1080P 1920×1080P 1920×1080P YPbPr 1.5G 1920×1080P

 
1) When AXS Rec Format is set to Rec Off, this output is selected when Technical > System Configuration > SD HDMI is set to On in the menu
2) When Project Frame Rate is 59.94.
3) When Project Frame Rate is 50.0.
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If a warning, caution, or operating condition that requires confirmation occurs on the unit, a message is 

displayed on the sub display, the REC lamp starts flashing, and a warning sound is emitted.

The buzzer is output to the built-in speaker or to the headphones connected via the headphone 

connector.

When the unit is turned on, a message appears on the sub display screen prompting you to execute APR 

if the auto adjustment for the image sensor (APR) has not been performed for a certain period of time. In 

this case, follow the on-screen instructions to execute APR (page 49).

Error Display

The unit will stop operation when the following kind of display occurs.

Error display 

indication

Buzzer REC lamp Cause and Solution

E + Error code Intermittent High-speed 

flashing

The unit may be defective. Recording stops even if 

REC is displayed on the viewfinder screen.

Turn off the power and check the connected 

equipment, cables, and media. If the error persists when 

the unit is turned on again, contact your Sony service 

representative. (If power cannot be turned off by setting 

the power switch to OFF, remove the battery pack or 

the DC IN source.)

Warning Display

When one of the following messages occurs, use the following table to resolve the problem.

Warning display 

indication

Buzzer REC lamp Cause and Solution

Media Full 1) Continuous High-speed 

flashing

Clips could not be recorded, copied, or split because 

there is no remaining capacity on the SxS memory card.

Replace immediately.

Battery End 1) Continuous High-speed 

flashing

The battery pack is dead. Recording is disabled.

Stop operation and recharge the battery pack.

Temperature High 1) Intermittent Flashing The internal temperature is high.

Turn off the unit and allow it to cool down before 

operating it again.

Warning display 

indication

Buzzer REC lamp Cause and Solution

Insufficient Voltage 1) Continuous High-speed 

flashing

The DC IN voltage is too low. Recording is disabled.

Connect another power source.

EXT. I/F Signal Error – – An error was detected with the signal on the mounting 

terminal for an expansion unit.

Check the connection to the AXS-R7 or other device.

AXS Recorder Temp. 

High 1)

– – The internal temperature of the AXS recorder is high.

Turn off the unit and allow it to cool down before 

operating it again.

1) Message is not displayed on the monitor screen.

Caution and Operation Confirmation Display

The following caution and operation confirmation messages may appear on the monitor screen or sub 

display, and warning icons may be displayed and messages displayed in the Info category > Camera 

Condition in the menu. Follow the instructions provided to resolve the issue.

Display indication Cause and Solution

Battery Error

Please Change Battery

An error was detected in the battery pack.

Replace with a normal battery pack.

Backup Battery End

Please Change

The remaining capacity of the backup battery is 

insufficient.

Replace the backup battery.

Cannot Use SxS(A)*

Please Change

A memory card that has been partitioned or a 

memory card containing more clips that can be 

handled by the unit was inserted.

The card cannot be used in the unit, and must be 

replaced.

Cannot Use SxS(A)*

Unsupported File System

A card using a different file system or an unformatted 

card was inserted.

The card cannot be used in the unit, and must be 

replaced or formatted using the unit.

Media Error

SxS(A)* Needs to be Restored

An error occurred with the memory card. The card 

requires restoration.

Restore the card.

SxS(A)* Error

Recording Halted

Playback Halted

Recording or playback stopped because an error 

occurred on the memory card.

If the problem persists, replace the memory card.

Error/Warning Indications
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Display indication Cause and Solution

Input AES/EBU is Invalid Emphasis Emphasis signal that is not compatible with the AES/

EBU input was input.

The unit is compatible with 50u-15u Emphasis only.

Input AES/EBU is not Pro Use A signal other than Professional Use was input to the 

AES/EBU input.

The unit is compatible with Professional Use only.

Fan Stopped The fan in the unit has stopped.

Avoid use under high temperature conditions. Turn 

the unit off and contact a Sony service representative.

AXS Recorder Fan Stopped The fan in the AXS-R7 that is connected to the unit 

has stopped.

Avoid use under high temperature conditions. 

Remove the AXS-R7 from the unit and contact a Sony 

service representative.

Unsupported FPS

Change AXS(A) to AXS S48 Memory

Unsupported AXS memory was detected.

Recording cannot be performed. Change the 

recording format for the AXS memory card, or change 

the card to an AXS-A512S48 or AXS-A1TS48.

Abnormal Lens Communication

Please Check “Lens IF” Setting  

The type of the connected lens does not match the 

unit’s setting.

Check the Technical > System Configuration > Lens 

Interface setting in the menu.

Please Execute APR The auto adjusting of the image sensor (APR) has not 

been executed for a certain period.

Execute APR by pressing the MENU dial.

Invalid setting value was reset:

Media/Clip Naming/Camera Position

Please save All File again

The setting of Clip Naming was reset because an 

invalid All-settings file is loaded.

Save the All-settings file again after setting the desired 

values.

XXXX License Y days Remaining 

(XXXX: Type of license, Y: Number of days remaining)

There are 2 days remaining before the license for the 

software option will expire.

* “SxS(B)” is displayed for the SxS memory card in slot B, “AXS(A)” is displayed for the AXS memory card in slot A of the AXS-R7, 

and “AXS(B)” is displayed for the AXS memory card in slot B of the AXS-R7.
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Table legend

Yes: Saved

No: Not saved

–: Not saved (temporary setting)

Shooting Menu

Item Sub-item File type

All

Shutter 1) Shutter Select Yes

Step/Cont. Select Yes

Add/Change Step Yes

Delete Step Yes

ND ND Position Yes

Exposure Index EI Select Yes

White Balance 1) Color Temp. Select Yes

Add/Change Step Yes

Delete Step Yes

LUT Select SDI 1/2 Yes

SDI 3/4 Yes

Monitor Yes

HDMI Yes

VF LUT Yes

SxS Rec Yes

Sub Rec Yes

Look Category –

Preset Look Select Yes

1) Selection options added or edited by a user are also saved.

Project Menu

Item Sub-item File type

All

Basic Setting Imager Mode Yes

Project Frame Rate Yes

AXS Rec Format Yes

SxS Rec Format Yes

Sub Rec Format Yes

SxS/Output De-Squeeze No

Assignable Button <1> Yes

<2> Yes

<3> Yes

<4> Yes

<User 1> Yes

<User 2> Yes

<User 3> Yes

<User 4> Yes

<User 5> Yes

All File Load SD Card –

Save SD Card –

File ID Yes

Format SD Card –

Items Saved in Files
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TC/Media Menu

Item Sub-item File type

All

Timecode Mode Yes

Manual Setting –

Reset –

TC Format Yes

TC Source –

Time Data Display Yes

Clip Name Format Camera ID Yes

Reel Number Yes

Camera Position Yes

Format Media AXS Slot A –

AXS Slot B –

SxS Slot A –

SxS Slot B –

SD Card –

Update Media AXS Slot A –

AXS Slot B –

SxS Slot A –

SxS Slot B –

Monitoring Menu

Item Sub-item File type

All

Output Format SDI 1/2 Yes

SDI 3/4 Yes

Monitor Yes

HDMI Yes

VF OSD Status Info Yes

Status Info Select Yes

Frame Line Yes

Frame Line Select Yes

SDI OSD Status Info Yes

Status Info Select Yes

Frame Line Yes

Frame Line Select Yes

Monitor OSD Status Info Yes

Status Info Select Yes

Frame Line Yes

Frame Line Select Yes

HDMI OSD OSD Status –

Status Info A Project Yes

Timecode Yes

Audio Level Meter Yes

Look Status Yes

Output LUT Yes

Recording LUT Yes

VF Status Yes

Lens Status Yes

Status Info B Project Yes

Timecode Yes

Audio Level Meter Yes

Look Status Yes

Output LUT Yes

Recording LUT Yes

VF Status Yes

Lens Status Yes

Display Info Focus Distance Format Yes
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Item Sub-item File type

All

Frame Line A Center Marker Yes

Aspect Ratio Yes

Aspect Safety Zone Yes

Picture Area Yes

Safety Zone Yes

User Frame Line Yes

Frame Line B Center Marker Yes

Aspect Ratio Yes

Aspect Safety Zone Yes

Picture Area Yes

Safety Zone Yes

User Frame Line Yes

Frame Line Color Yes

Center Marker Yes

Safety Area Yes

Aspect Ratio Type Yes

Aspect Ratio Select Yes

Aspect Ratio Mask Yes

Aspect Safety Area Yes

Frame Line on Playback Yes

User Frame Line Width Yes

Height Yes

H Position Yes

V Position Yes

VF Display VF LUT Yes

Status Info Yes

Status Info Select Yes

Frame Line Yes

Frame Line Select Yes

Color Yes

VF Function Double Speed Scan Yes

Peaking Frequency Yes

Zebra Yes

Zebra Select Yes

Zebra1 Level Yes

Zebra1 Aperture Level Yes

Zebra2 Level Yes

Audio Menu

Item Sub-item File type

All

Audio Input CH-1 Audio Select Yes

CH-2 Audio Select Yes

CH-1 Audio Level Yes

CH-2 Audio Level Yes

MIC Reference Yes

Audio Monitor Monitor CH Yes

Monitor Level Yes

Audio Configuration Input Limiter Mode Yes

AGC Level Yes

AGC Mono/Stereo Yes

MIC Input Mono/Stereo Yes

Phantom Power +48V Yes

Monitor Output CH Pair Yes

Headphone Mono/ST Yes
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Technical Menu

Item Sub-item File type

All

Test Signals Color Bars Yes

Color Bars Type Yes

1kHz Tone on Color Bars Yes

Test Saw Yes

Switch & Rec Light Lock Operator Side Yes

Lock Assistant Side Yes

Rec Light Yes

Rec Start/Stop Beep Yes

System Configuration Fan Control Yes

Lens Interface Yes

SDI Rec Remote Trigger Yes

SD HDMI Yes

Shutter Mode Yes

APR APR –

Reset –

Battery Near End:Info Battery Yes

End:Info Battery Yes

Near End:Sony Battery Yes

End:Sony Battery Yes

Near End:Other Battery Yes

End:Other Battery Yes

Detected Battery –

DC Voltage Alarm DC Low Voltage1 Yes

DC Low Voltage2 Yes

DC(24V) Low Voltage1 Yes

DC(24V) Low Voltage2 Yes

Control Display Brightness level Yes

Genlock Input Source Yes

Reference Lock Type –

Maintenance Menu

Item Sub-item File type

All

Clock Set Time Zone Yes

Date Mode Yes

Date –

Time –

Language Select Yes

Hours Meter Camera(System) –

R7 Recorder(System) –

Camera(Resettable) –

R7 Recorder(Resettable) –

Reset-Cam(Resettable) –

Reset-R7(Resettable) –

Reset to Default Reset –

License Options Install: xxx –

Anamorphic –

Full Frame –

Unique Device ID –

Firmware Camera –

AXS –

FW Update-camera –
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MPEG-4 Visual Patent Portfolio 

License

THIS PRODUCT IS LICENSED UNDER THE MPEG-4 

VISUAL PATENT PORTFOLIO LICENSE FOR THE 

PERSONAL AND NON-COMMERCIAL USE OF A 

CONSUMER FOR

(i) ENCODING VIDEO IN COMPLIANCE WITH THE 

MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) 

AND/OR

(ii) DECODING MPEG-4 VIDEO THAT WAS 

ENCODED BY A CONSUMER ENGAGED IN A 

PERSONAL AND NON-COMMERCIAL ACTIVITY 

AND/OR WAS OBTAINED FROM A VIDEO PROVIDER 

LICENSED BY MPEG LA TO PROVIDE MPEG-4 VIDEO.

NO LICENSE IS GRANTED OR SHALL BE IMPLIED 

FOR ANY OTHER USE. ADDITIONAL INFORMATION 

INCLUDING THAT RELATING TO PROMOTIONAL, 

INTERNAL AND COMMERCIAL USES AND 

LICENSING MAY BE OBTAINED FROM MPEG LA, 

LLC. SEE HTTP://WWW.MPEGLA.COM

MPEG LA is offering licenses for (i) manufacturing/

sales of any storage media storing MPEG-4 Visual 

video information (ii) distribution/broadcasting of 

MPEG-4 Visual video information in any manner 

(such as online video distribution service, internet 

broadcasting, TV broadcasting).

Other usage of this product may be required to 

obtain license from MPEGLA. Please contact MPEG 

LA for any further information. MPEG LA. L.L.C., 250 

STEELE STREET, SUITE 300, DENVER, COLORADO 

80206

http://www.mpegla.com

MPEG-4 AVC Patent Portfolio License

THIS PRODUCT IS LICENSED UNDER THE AVC 

PATENT PORTFOLIO LICENSE FOR THE PERSONAL 

USE OF A CONSUMER OR OTHER USES IN WHICH IT 

DOES NOT RECEIVE REMUNERATION TO

(i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC 

STANDARD (“AVC VIDEO”) AND/OR

(ii) DECODE AVC VIDEO THAT WAS ENCODED BY 

A CONSUMER ENGAGED IN A PERSONAL ACTIVITY 

AND/OR WAS OBTAINED FROM A VIDEO PROVIDER 

LICENSED TO PROVIDE AVC VIDEO.

NO LICENSE IS GRANTED OR SHALL BE IMPLIED 

FOR ANY OTHER USE. ADDITIONAL INFORMATION 

MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE 

HTTP://WWW.MPEGLA.COM

On Accessing Software to which the 

GPL/LGPL Applies

This product uses software to which the GPL/LGPL 

applies. This informs you that you have a right to 

have access to, modify, and redistribute source 

code for these software programs under the 

conditions of the GPL/LGPL.

The source code is provided on the internet. 

Use the following URL and follow the download 

instructions.

http://www.sony.net/Products/Linux/common/

search.html

We would prefer that you do not contact us about 

the contents of the source code.

For the content of these licenses, see “License1.

pdf” in the “License” folder of the supplied CD-

ROM.

Adobe Reader must be installed on your computer 

to view PDF files.

If Adobe Reader is not installed on your computer, 

you can download it by accessing the following 

URL.

http://get.adobe.com/reader/

Open Software Licenses

On the basis of license contracts between Sony 

and the software copyright holders, this product 

uses open software.

To meet the requirements of the software 

copyright holders, Sony is obligated to inform you 

of the content of these licenses.

For the content of these licenses, see “License1.

pdf” in the “License” folder of the supplied CD-

ROM.

 

Licenses
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General Specifications

Mass Approx. 3.9 kg (8 lb 9.6 oz) (excluding 

handle, VF attachment, bottom 

cover)

Dimensions

  See page 77.

Power requirements

  12 V DC (11 V to 17 V)

  24 V DC (22 V to 32 V)

Power consumption

  Approx. 60 W (when recording XAVC)

Operating temperature

  0 °C to 40 °C (32 °F to 104 °F)

Storage temperature

  –20 °C to +60 °C (–4 °F to +140 °F)

Continuous operating time

  Approx. 60 minutes (using BP-FLX75)

Recording format (video)

 RAW SQ (4K,17:9)  

(when the AXS-R7 is attached)

 X-OCN ST (6K 3:2, 4K 4:3, 4K 17:9) 

(when the AXS-R7 is attached)

 X-OCN LT (6K 3:2, 4K 4:3, 4K 17:9) 

(when the AXS-R7 is attached)

 XAVC-I Class480 (4K, QFHD)

 XAVC-I Class300 (4K, QFHD)

 MPEG HD422 (HD)

Recording format (audio)

 LPCM 8CH (2CH recording/playback),  

24-bit, 48 kHz

Recording frame rate

 RAW SQ (when the AXS-R7 is attached):

  4K 17:9/3.8K 16:9

   59.94P/50P/29.97P/25P/24P/ 

23.98P

 X-OCN (when the AXS-R7 is attached):

  6K 3:2

   24P/23.98P

  4K 4:3

   24P/23.98P

  4K 17:9/3.8K 16:9

   59.94P/50P/29.97P/25P/24P/ 

23.98P

 XAVC-I Class480:

  4K: 4096×2160

   29.97P/25P/24P/23.98P

  QFHD: 3840×2160

   29.97P/25P/ 23.98P

 XAVC-I Class300:

  4K: 4096×2160

   59.94P/50P/29.97P/25P/24P/ 

23.98P

  QFHD: 3840×2160

   59.94P/50P/29.97P/25P/23.98P

 MPEG HD422(50Mbps):

  HD: 1920×1080

   29.97P/25P/23.98P/59.94i/50i

Recording/playback time

 XAVC-I Class480 23.98P

  Approx. 34 minutes when using  

SBP-128B/C/D

 XAVC-I Class300 23.98P

  Approx. 54 minutes when using  

SBP-128B/C/D

 MPEG2 HD422

  Approx. 108 minutes when using  

SBS-64G1A/B

[Note]

The recording and playback times are for a continuous 

recording as a single clip. The actual times may be shorter, 

depending on the number of clips recorded. The recording/

playback time may vary due to usage conditions and 

memory characteristics.

Camera

Imaging device

  35 mm full size, single-chip CMOS 

image sensor

Number of pixels

  24.8 M (total)

Built-in filters

ND filter A

Clear 0.3  

(1/2)

0.6  

(1/4)

ND filter B Clear Clear 0.3  

(1/2)

0.6  

(1/4)

0.9 

(1/8)

0.9 

(1/8)

1.2 

(1/16)

1.5 

(1/32)

1.8 

(1/64)

1.8 

(1/64)

2.1 

(1/128)

2.4 

(1/256)

ISO sensitivity

  ISO 500 (D55 light source)

Lens mount

  PL mount (with lens mount adaptor)

Flange focal length

  52 mm

Latitude

  15+ stops

Input/Output

Audio input

  CH-1/CH-2: XLR-type 5-pin (female) (1), 

LINE / AES/EBU / MIC / MIC+48V 

selectable

DC input

  XLR-type 4-pin (male), 11 V to 17 V or 

22 V to 32 V DC

DC output (12 V)

  Hirose 4-pin (1), 

11 V to 17 V DC (Output voltage: 

Same as input voltage, Maximum 

output current: 1.0 A), 

22 V to 32 V DC (Output voltage: 

15 V, Maximum output current: 

0.8 A), 

Using battery adaptor

[Notes]

ˎˎ You can output a REC Tally signal and input a REC Trigger 

signal through the 12V OUT connector.

ˎˎ Connect to the 12V OUT connector only devices with 

current consumption of 1.0 A or lower when the input 

voltage is 11 V to 17 V, or 0.8 A or lower when the input 

voltage is 22 V to 32 V.

DC output (24 V)

  Fischer 3-pin (2), 

11 V to 17 V DC (Output voltage: 

24 V, Maximum output current: 

1.0 A), 

22 V to 32 V DC (Output voltage: 

Same as input voltage, Maximum 

output current: 2.0 A)

[Note]
Connect to the 24V OUT connector only devices with current 

consumption of 1.0 A or lower when the input voltage is 

11 V to 17 V, or 2.0 A or lower when the input voltage is 22 V 

to 32 V.

SDI output BNC type (4)

  3G-SDI: SMPTE ST424/425 Level B-DL/DS

  HD SDI: SMPTE ST292 compliant

AUX

  LEMO 5-pin (1)

Specifications
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Viewfinder output

  LEMO 26-pin (1)

Network

  RJ45 type (1)

Remote control

  8-pin (1)

MONITOR output

  BNC type (1)

  HD SDI: SMPTE ST292 compliant

Timecode input

  TC IN: BNC type (1)

GENLOCK input

  BNC type (1)

HDMI output

  Type A (1)

External device connector

  USB host: Type A (1)

Headphones output

  Stereo mini jack (1)

Speaker output

  Monaural

Media Slots

Type ExpressCard/34 slot (2)

  SD card slot (1)

Supplied Accessories

VF attachment (1)

Handle (1)

VF cable (1)

Shim (circular) (1)

Shim (1/3 arc) (15)

Lens mount cover (1)

Before Using this Unit (1)

Operating Instructions (CD-ROM) (1)

Optional Accessories

0.7-inch type viewfinder

  DVF-EL200

7-inch type viewfinder

  DVF-L700

VF cable for attaching DVF-L700

  A-2201-632-A or A-2201-633-A

Portable Memory Recorder

  AXS-R7

SxS memory cards (SxS-1/SxS Pro/SxS Pro+)

  SBP-256D, SBP-128B/C/D, SBP-64A/B/

C/D, SBP-32G1A/B

Card Reader

  SBAC-US30, SBAC-UT100, AXS-AR1

Shoulder Adaptor (attaches to VCT-14 using V shoe)

  VCT-FSA5

PL mount lens

  SCL-PK6/F (Feet), SCL-PK6/M (Meters) 

(6-lens kit: 20, 25, 35, 50, 85, 135 

mm), 

SCL-P11X15 (11 mm to 16 mm 

zoom)

Battery Pack

  BP-FL75, BP-FLX75

AC Adaptor

  AC-DN2B, AC-DN10

Microphone

  ECM-680S, ECM-678*, ECM-674* 

(*: EC-0.5X3F5M 3-pin XLR to 5-pin 

XLR adaptor cable required)

Dual Battery Adaptor

  BKW-L200 (connection via battery 

connection adaptor)

SDI/HDMI Monitor

  BVM series, PVM series, LMD series

XQD memory cards (QDA-EX1 XQD to SxS 

ExpressCard Adaptor required)

  QD-S64E, QD-S32E, QD-N64, QD-

G128A, QD-G64A, QD-G32A

Design and specifications are subject to change 

without notice.

Notes 

ˎˎ Always make a test recording, and verify 

that it was recorded successfully. SONY 

WILL NOT BE LIABLE FOR DAMAGES OF ANY 

KIND INCLUDING, BUT NOT LIMITED TO, 

COMPENSATION OR REIMBURSEMENT ON 

ACCOUNT OF FAILURE OF THIS UNIT OR ITS 

RECORDING MEDIA, EXTERNAL STORAGE 

SYSTEMS OR ANY OTHER MEDIA OR STORAGE 

SYSTEMS TO RECORD CONTENT OF ANY TYPE.

ˎˎ Always verify that the unit is operating 

properly before use. SONY WILL NOT BE LIABLE 

FOR DAMAGES OF ANY KIND INCLUDING, 

BUT NOT LIMITED TO, COMPENSATION OR 

REIMBURSEMENT ON ACCOUNT OF THE LOSS 

OF PRESENT OR PROSPECTIVE PROFITS DUE 

TO FAILURE OF THIS UNIT, EITHER DURING THE 

WARRANTY PERIOD OR AFTER EXPIRATION OF 

THE WARRANTY, OR FOR ANY OTHER REASON 

WHATSOEVER.

ˎˎ SONY WILL NOT BE LIABLE FOR CLAIMS OF 

ANY KIND MADE BY USERS OF THIS UNIT OR 

MADE BY THIRD PARTIES.

ˎˎ SONY WILL NOT BE LIABLE FOR THE LOSS, 

REPAIR, OR REPRODUCTION OF ANY DATA 

RECORDED ON THE INTERNAL STORAGE 

SYSTEM, RECORDING MEDIA, EXTERNAL 

STORAGE SYSTEMS OR ANY OTHER MEDIA OR 

STORAGE SYSTEMS.

ˎˎ SONY WILL NOT BE LIABLE FOR THE 

TERMINATION OR DISCONTINUATION OF ANY 

SERVICES RELATED TO THIS UNIT THAT MAY 

RESULT DUE TO CIRCUMSTANCES OF ANY 

KIND.
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Dimensions

147 (5 7/8)

25 (1)

25 (1)

25 (1)

25 (1)

15.2 (5/8)

27.7 (1 1/8)

25 (1)

4.45 (3/16)

25 (1)

25 (1)

25 (1)

25 (1)
13 (17/32)

Ø5.2×5

UNC 1/4-20×10.5

2-UNC 3/8-16×13.5

UNC 1/4-20×11

2-UNC 3/8-16×10.5

0.5 (1/32)

25 (1)

25 (1)
25 (1)

17 (11/16)

10-UNC 3/8-16×10.7

10-UNC 1/4-20×10.7

158  
(6 1/4)

170 (6 3/4) 40 (1 5/8)

2-M3×5

2-M3×5

Unit: mm (inches)

235 (9 3/8)

236  
(9 3/8)

Trademarks

ˎˎ XAVC and  are registered trademarks of 

Sony Corporation.

ˎˎ The terms HDMI and HDMI High-Definition 

Multimedia Interface, and the HDMI Logo are 

trademarks or registered trademarks of HDMI 

Licensing LLC in the United States and other 

countries.

ˎˎ All system names and product names are 

registered trademarks or trademarks of their 

respective owners. Trademarked items are not 

indicated by ® or ™ symbols in this document.
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